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NOTES



This User Manual is designed to start your journey with the MakerBot® 
Replicator® 2X Experimental 3D Printer in the right direction. Your 
MakerBot Replicator 2X is optimized for ABS, a traditional thermoplastic 
that can be tricky and unpredictable. In order to achieve great results,  
you will need to experiment and tinker. That’s why it’s so crucial to take  
the time to learn about your new machine.

In this manual, you will learn how to set up and start using your Replicator 
2X. You will also be introduced to Thingiverse and MakerWare. By the time 
you finish reading, you will know everything you need to start experimenting.

We are so excited to welcome you to the MakerBot community.  
Let’s get started!

Welcome
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SAFETY AND COMPLIANCE

RADIO AND TELEVISION INTERFERENCE
This equipment has been tested and found to comply with the limits for a Class B digital 

device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable 

protection against harmful interference in a residential installation.  This equipment 

generates, uses and can radiate radio frequency energy and, if not installed and used in 

accordance with the instructions, may cause harmful interference to radio communications.  

However, there is no guarantee that interference will not occur in a particular installation.  If 

this equipment does cause harmful interference to radio or television reception, which can be 

determined by turning the equipment off and on, the user is encouraged to try to correct the 

interference by one or more of the following measures:

•   Reorient or relocate the receiving antenna.

•   Increase the separation between the equipment and the receiver.

•   Connect the equipment into an outlet on a circuit different from that 

to which the receiveris connected.

•   Consult the dealer or an experienced radio/TV technician for help.

 

 You may also find helpful the following booklet, prepared by the FCC: “How to Identify 

and Resolve Radio-TV Interference Problems.”  This booklet is available from the U.S. 

Government Printing Office, Washington D.C. 20402.

 

Changes and Modifications not expressly approved by the manufacturer or registrant 

of this equipment can void your authority to operate this equipment under Federal 

Communications Commission rules.

MANUFACTURER

MakerBot Industries, LLC

One MetroTech Center, 21st Floor

Brooklyn, NY 11201

347.334.6800

  WELCOME

I. T. E.
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WARNING: The MakerBot Replicator 2X Experimental 3D Printer generates high temperatures  

and includes moving parts that can cause injury. Never reach inside the MakerBot Replicator 2X  

while it is in operation. Always allow the MakerBot Replicator 2X to cool down before reaching inside.

WARNING: Do not leave the MakerBot Replicator 2X unattended during operation.
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PRINTING 
Print Technology:    Fused Filament Fabrication 

Build Volume: 9.7”W x 6.4”L x 6.1”H 
   [24.6 cm x 16.3 cm x 15.5 cm]

Layer Height Settings: High 100 microns [0.0039 in]
  Medium 200 microns [0.0079 in]
  Low 300 microns [0.0118 in]

Positioning Precision:  XY: 11 microns [0.0004 in]; 
  Z: 2.5 microns [0.0001 in]

Filament Diameter:  1.75 mm [0.069 in]

Nozzle Diameter:  0.4 mm [0.015 in]

SOFTWARE
Software Bundle: MakerBot MakerWare™ 

File Types:  STL, OBJ, Thing

Supports:   Windows [7+], Ubuntu [11.10+], 
  Mac OS X [10.6+]

PHYSICAL DIMENSIONS
Without Spools:  19.1 x 12.8 x 14.7 in [49 x 32 x 38 cm]

With Spools:  19.1 x 16.5 x 14.7 in [49 x 42 x 38 cm]

SAFETY AND COMPLIANCE CONTINUED

SPECIFICATIONS

Shipping Box:  22.75 x 22.75 x 16.75 in  
  [57.8 x 57.8 x 42.5 cm]
Weight:   27.8 lbs [12.6 kg]

Shipping Weight: 39.0 lbs [79.7 kg] [All packages]

TEMPERATURE
Ambient Operation:  15°–32° C [60°–90° F]

Storage Temperature:  0°–32° C [32°–90° F]

ELECTRICAL
AC Input:   100–240V, ~4 amps, 50–60 Hz

Power Requirements:  24V DC @ 9.2 amps

Connectivity: SD card [FAT16, max 2 GB]

MECHANICAL
Chassis:   Powder-coated steel

Body:   PVC Panels

Build Platform:  356 aluminum

XYZ Bearings:  Wear-resistant,   
  oil-infused bronze

Stepper Motors:  1.8° step angle with 1/16  
  micro-stepping.

This safety alert symbol precedes each safety message in this manual. This symbol indicates 

a potential safety hazard that could harm you or others or cause product or property damage.

CAUTION: In case of emergency disconnect power supply from wall socket.

CAUTION: The socket outlet must be located near the equipment and must be easily accessible

CAUTION: The Replicator 2X melts plastic during printing. Plastic odors are emitted during this 

operation. Make sure to set up the Replicator 2X in a well-ventilated area.



The MakerBot Replicator 2X Experimental 3D Printer makes solid,  three-
dimensional objects out of melted MakerBot Filament. Your  3D design 
files are translated into instructions for the MakerBot Replicator 2X and 
read by the machine via SD card. The MakerBot Replicator 2X then heats 
the MakerBot Filament and squeezes it out through a nozzle onto a heated 
surface to build a solid object, layer by layer. This method is called Fused 
Filament Fabrication [FFF].

HOW IT WORKS

9WELCOME



When you set up your MakerBot® Replicator®2X Experimental 3D Printer, 
remember that it was built and packaged very carefully at the MakerBot 
Factory. We hope you’ll take your time and be just as careful unpacking it 
and getting set up.

Setup

2



11

UNPACKING YOUR MAKERBOT REPLICATOR 2X

1  Opening the Box 

1a. Place the MakerBot Replicator 2X box  
on the ground. Open the box and remove the 
top cardboard sheet.

1b. Remove the MakerBot Replicator 2X User 
Manual. We recommend that you review 
the manual to guide you through the setup 
process and keep it handy as you unpack the 
contents of the box. If you find that anything 
described in the manual is missing, email us 

at support@makerbot.com.

1c. Remove the layer of foam and the sheet 

of cardboard underneath.

1d. Remove the two protective foam pieces 
from the sides of the MakerBot Replicator 2X.

2  Removing the MakerBot 
Replicator 2X from the box

Open the plastic covering and firmly grasp 
the frame of the MakerBot Replicator 2X. 
Be careful not to grip the rods or belts of the 
gantry system. Lift it out of the box and place 
it on a stable surface.

CAUTION: Do not force or tear anything 

during unpackingand setup. This may 

damage the MakerBot Replicator 2X.



MAKERBOT REPLICATOR 2X DIAGRAMS

[1] GANTRY SYSTEM

[2] LCD PANEL

[3] HEATED BUILD PLATE

[4] BUILD PLATFORM

[5] THREADED Z-AXIS ROD

[6] ENCLOSURE DOOR HANDLE

[7] FILAMENT GUIDE TUBES

[8] EXTRUDER CABLE

[9] EXTRUDERS

[10] FILAMENT SPOOL

[11] SPOOL HOLDERS
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MAKERBOT REPLICATOR 2X DIAGRAMS CONTINUED

[1] FAN GUARDS

[2] EXTRUDER FANS

[3] EXTRUDER NOZZLES

[4] EXTRUDER LEVER ARMS

[5] FAN BOLTS

[6] CARTRIDGE HEATERS

[7] THERMAL CORES

[8] DRIVE BLOCKS

[9] EXTRUDER CABLE MOUNT

[10] MOTOR CABLE CONNECTORS

[11] EXTRUDER MOTORS

[12] HEAT SINKS

[13] BAR MOUNT

[14] SPACERS

[15] EXTRUDER CARRIAGE
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Front view of extruders

Angled view of extruders



ACCESSORY BOX
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* More options available at makerbot.com/store

2

Filament guide tubes

USB-A to USB-B 
cable

1

4

Hex wrenches

MakerBot ABS 
Filament [1 lb Spool]

1

Power supply  
and cable

SD card

1

1

*

Handle and bolts

3

Kapton tape sheets

1

1

Support card

2

Spool holders

MakerBot tape 

applicator

1

1

PTFE-based grease



ACCESSORY BOX CONTINUED
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3  Removing the Accessory Box

 3a. Remove the two remaining protective 
foam pieces from the bottom of the 

MakerBot Replicator 2X’s box.

3b. Lift out the accessory box. This box 
contains the remaining items from the 
Accessory Box section. 

4  Freeing the Extruders 

4a. Use strong scissors or a wire cutter to 
cut the zip ties holding the gantry system 
in place. Discard the zip ties and the plastic 

pieces holding them in place.

4b. A small plastic piece attached to the 
X-axis belt and gantry rods prevents the 
extruder from moving. Carefully snap the 
piece off of the rods and tilt it to slide it  
off of the belt.



SETTING UP YOUR MAKERBOT REPLICATOR 2X

5  Installing the Enclosure 
Door Handle

5a. Locate the handle kit in the accessory box. 

The kit includes your enclosure door handle 

and two buttonhead bolts.

5b. Open the enclosure door. To do this, 

reach through the top of the MakerBot 

Replicator 2X, push the door outward, 

and raise it to a 90° angle.

5c. Place the handle on top of the  
enclosure door. Align the holes in the  
ends of the handle with the pre-drilled  

holes in the enclosure door.

5d. Use your fingers to thread each bolt 
through the holes in the enclosure door  
and the handle. Use a Phillips head 
screwdriver to tighten the bolts. Close  
the enclosure door.

16
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SETTING UP YOUR MAKERBOT REPLICATOR 2X CONTINUED

6  Installing the Filament Guide 
Tubes and Spool Holders

6a. Locate the two filament guide tubes. 
Insert one end of a filament guide tube into 
the hole in the top of one of the extruders. 
Push the filament guide tube in as far as it 
will go. Insert the end of the other filament 
guide tube into the hole on the top of the 
second extruder. Push the filament guide 
tube in as far as it will go.

6b. Insert the other end of one filament 
guide tube into the corresponding guide 
tube holder on the back of the MakerBot 
Replicator 2X. Make sure that the end  
of each filament guide tube is flush with  
the bottom of its guide tube holder.  
The filament guide tube should not hang 
down past the bottom of the guide tube 
holder. Repeat this process for the second 

filament guide tube.

6c. Locate the spool holders. Install  
the spool holders in the two rectangular 
openings on the back of the MakerBot 
Replicator 2X. To install a spool holder,  
tilt it and insert the square end into  
one of the openings

Spool
Holder



SETTING UP YOUR MAKERBOT REPLICATOR 2X CONTINUED

7  Mounting the Filament Spool

7a. Open the box containing your starter 
spool of MakerBot ABS Filament. Remove 
the spool from its plastic bag.

7b. Mount the spool on the left spool 
holder [when viewed from the back of the 
Replicator 2X]. Orient the spool so that it will 
unwind counterclockwise. Push the spool 
onto the spool holder until it locks. Do not 
let the filament uncoil or tangle as you load 
the spool onto the back of the MakerBot 
Replicator 2X. 

NOTE: If a spool unwinds in the wrong direction, just 

turn it around. Spools are designed so that they can 

be installed on either side. 

8 Installing the Enclosure Lid

8a. Locate the box containing the acrylic 
enclosure lid. The enclosure lid is shipped 
in a separate box and is not included in the 
same box as your MakerBot Replicator 2X. 

8b. Unpack the enclosure lid and place it 
over your MakerBot Replicator 2X so that 
it covers the top of the frame, the extruder 
cable, and the filament guide tubes. The 
small indentations at the corners of the lid 
should line up with the bolt heads on the top 
of the MakerBot Replicator 2X’s frame.

18
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SETTING UP YOUR MAKERBOT REPLICATOR 2X CONTINUED

9  Attaching the Power Supply

10a. Locate the power supply and cable. 
Attach the cable to the power supply.

10b. Ensure that the power switch on  
the MakerBot Replicator 2X is set to  
the OFF position.

10c. Insert the power supply connector into 
the power input port on the back of the 
MakerBot Replicator 2X. Ensure that the flat 
side of the connector faces down.

NOTE: If at any time you need to unplug the 

MakerBot Replicator 2X, pull on the connector itself 

to release it from the power input port.

10 Powering On the MakerBot 
Replicator 2X

11a. Plug the AC power cord into  
an electrical outlet.

11b. Set the power switch to the  

ON position.

11c. The MakerBot Replicator 2X will  
display welcome text on the LCD panel. This 
is the beginning of the startup script that 
will guide you through initial  

calibration and your first 3D print.

CAUTION: The socket-outlet must be 

installed near the equipment and must  

be easily accessible.



After you switch on the MakerBot® Replicator® 2X Experimental 3D 
Printer, the LCD panel will light up and display text. This text is the 
beginning of the Startup Script. The Startup Script will guide you through 
leveling the build plate, loading MakerBot ABS Filament, and creating 
your first 3D print.

Startup

3
CHAPTER

3
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START UP

NOTE: If you don’t see the Startup Script, use the up and down arrow buttons to scroll through the top level 

menu on the LCD panel and use the M button to select Utilities. Scroll to Run Startup Script and select it. 

You can use these menus to return to the Startup Script at any time. You can view videos of the startup 

process on the MakerBot Replicator 2X video page at makerbot.com/support/replicator2x/videos. If you 

have any problems or questions, refer to the included Troubleshooting and Maintenance Guide or contact 

MakerBot Support by emailing support@makerbot.com.

Four arrow buttons  
surround a central M 
button. Use the arrows to 
navigate through the LCD 
menus and the M button 
to make selections.

The left arrow 
often allows you  
to go back or  
cancel an action.

THE LCD KEYPAD

•  A solid red M means 
the MakerBot Replicator 2X 
is working.

•  A blinking red M means the 
MakerBot  Replicator 2X is 
waiting for user input.



LEVELING THE BUILD PLATE

 ! Why Leveling Is Important

•   If the build plate is too far from the 
extruder nozzles, or if one part of the 
plate is farther away from the nozzles 
than another part, your 3D prints might 
not stick to the build plate.

•   If the build plate is too close to the 
extruder nozzles, the build plate can block 
the MakerBot Filament from extruding 
from the nozzles. This can also tear the 
Kapton tape applied to the build plate 
and scratch the aluminum 
surface underneath.

•   Leveling your build plate often will help 
ensure that objects adhere well to the plate.

 How to Level the Build Plate

Three knobs lower and raise  the build plate.

•   Tightening the knobs [turning them 
counterclockwise] moves the build plate 
away from the extruder nozzles.

•   Loosening the knobs [turning them 
clockwise] moves the build plate closer 
to the extruder nozzles.

•   The distance between the extruder 
nozzles and the build plate should be 
about the thickness of the MakerBot 
Support card included with your 

MakerBot Replicator 2X.

NOTE: To view a video of the build plate leveling 

process, go to the MakerBot Replicator 2X video 

page at makerbot.com/support/replicator2x/videos.

22

 1 Adjust the Knobs as Directed

When directed by the LCD screen, tighten 
each of the three knobs underneath the 
build platform approximately four turns. 

Next, the script will prompt you to adjust the 
knobs individually. Use the MakerBot Support 
business card or a thin piece of paper to check 
the plate height above each knob.

As you adjust each knob, make sure the 
MakerBot Support card just slides between 
the nozzles and build plate. You should feel 
some friction on the card but still be able 
to easily pass the card between the plate 
and the extruder nozzles without tearing or 
damaging the card.
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LEVELING THE BUILD PLATE   CONTINUED

2 Adjust Each Knob Again

The script will prompt you to adjust each 
knob again. This allows for fine tuning. This 
time, the Support card should slide between 
the build plate and nozzles with more friction.

3 Confirm your Adjustment

After the second set of adjustments, the 
nozzles will move to the center of the build 
plate. Confirm that the MakerBot Support 
card slides between the nozzles and plate 
with a moderate amount of friction.

NOTE: During leveling, it is okay for the nozzle to 

be very slightly closer to the center of the build 

plate than to the rest of the plate.

4 Finish Leveling 

When you have completed the initial 
leveling tasks, the LCD menu will display 
the following text: “Aaah, that feels much 
better. Let’s go on and load some plastic!” 
Before you can print, you must load the 
MakerBot ABS Filament into the extruder. 
The extruder will heat the filament and use 
the melted material to build things.

NOTE: If you have problems with this process or 

if you need to level your build plate again, you can 

use the up and down arrows to scroll through the 

top-level menu on the LCD panel and use the M 

button to select Utilities. Scroll to Level Build Plate 

and select it. You can use these menus to return to 

the leveling script at any time.
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LOADING MAKERBOT FILAMENT

 1 Remove the Enclosure Lid

Lift the enclosure lid from the top of the 

MakerBot Replicator 2X and set it aside.

 2 Detach the Filament Guide 
Tube on the Right

Locate where the right-side filament guide 

tube enters the right extruder. Detach the guide 

tube by gently pulling it out of the extruder.

3  Feed the Filament through 
the Filament Guide Tube

Free the end of the MakerBot ABS Filament 
from your starter spool. Use scissors to cut 
away any bent filament and feed the end of 
the spooled filament into the left side filament 
guide tube [when viewed from the back] 
where it attaches to the back of the MakerBot 
Replicator 2X. Continue to feed the filament in 
until it emerges from the other end of the tube.

NOTE: To avoid filament jams, always ensure that 

any filament spool you mount on the Replicator 2X 

feeds from the bottom of the spool toward the top. 

Filament mounted on the right spool holder [when 

viewed from the back] should always unspool 

clockwise and filament loaded onto the left spool 

holder should always unspool counterclockwise.

Filament 
Guide 
Tubes

Extruders

Filament 
Spool

Filament
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LOADING MAKERBOT FILAMENT   CONTINUED

4 Press the M to Begin Heating 
the Right Extruder

After you feed the MakerBot ABS Filament 
all the way through the filament guide tube, 
press the M button on the LCD panel. The 
MakerBot Replicator 2X will start to heat the 
right extruder.

CAUTION: Do not touch the extruders while 

they are heating — they heat to 230° C.

5 Press the M to continue

After the extruder reaches 230° C, the LCD 
panel will prompt you to load filament into 
the right extruder. Click through the message 
until your MakerBot Replicator 2X asks you to 
press the M when you see plastic extruding.

6 Push the Filament into the 
Right Extruder

Take the end of the MakerBot ABS Filament 
emerging from the end of the filament guide 
tube and firmly push it into the hole in the top 
of the right extruder. Ensure that the filament 
goes into the center of the opening and doesn’t 
get caught at the edge of the opening.

Maintain pressure on the filament and 
continue pushing it into the opening.

After about five seconds, you should begin 
to feel the motor pulling in the filament. 
Maintain pressure for another five seconds 
and then let go.

Press the M
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LOADING MAKERBOT FILAMENT   CONTINUED

7 Stop Extrusion

After a few moments, you should see a thin 
string of the MakerBot ABS Filament come 
out of the right extruder nozzle. The filament 
might curl and then straighten; this is normal. 
Press the M button to stop extrusion.

NOTE: Don’t be surprised if the plastic that initially 

comes out of the nozzle is not the color you 

expected. This is filament left over from testing. 

Wait until you see the color that you loaded come 

out of the nozzle before you press the M button.

8 Reattach the Filament Guide Tube

Push the guide tube back into the opening 
on the top of the right extruder.
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LOADING MAKERBOT FILAMENT   CONTINUED

9 Remove the Extruded Plastic

Wait a few minutes for the extruded ABS plastic 
to cool, then pull it away from the right extruder 
nozzle. You can discard this extra plastic.

CAUTION: Do not touch the nozzle;  

it may still be hot.

Don’t leave plastic clinging to the extruder 
nozzles. This can cause newly extruded plastic 
to stick to the nozzles instead of the build plate.

NOTE: If you have problems or need to load 

MakerBot Filament again, you can use the up and 

down arrows to scroll through the top-level menu 

on the LCD panel and use the M button to select 

Utilities. Scroll to Change Filament and select it. 

Then select Load Right or Load Left. You can use 

these menus to return to the load scripts at any time.

   Unloading MakerBot 
ABS Filament

If you need to unload filament, the  
LCD menu will walk you through the 
process. To run the script for unloading  
the filament from either extruder, go to  
the LCD panel and select Utilities >  
Filament Options > Unload.
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TROUBLESHOOTING

Can’t load filament?
If you are having problems loading filament 
into one of the extruders, perform the 
following steps:

1.   Go to the LCD panel and select Utilities 
> Filament Options > Unload. This option 
heats the extruders. 

2.   Set the extruder arm to the open position.

3.   Make a fresh cut at the end of the 
filament. It is important that the filament 
have nobends in it. If it does, cut off the 
bentsection of filament. 

4.   Insert the filament into the hole at the top 
of the extruder. Keep pushing it in until you 
start to see plastic come out of the nozzle.

5.   When the filament is successfully 
loaded, set the extruder lever arm to the 
closed position.

If filament still doesn’t emerge from the 
nozzle, remove the filament from the top of 
the extruder and check for a bend at the end 
of the filament. If the filament is bent, it is 
possible that the filament is slipping under 
the extruder bearing instead of entering the 
extruder heater. Remove the extruder fan 
and assembly using the instructions in the 
section Disassembling an Extruder. This 
will allow you to watch the filament travel 
through the extruder and determine where 
the filament is getting stuck.

It is also possible that you are unable to load 
filament because a broken piece of filament 
remains inside of the extruder. Remove 
the extruder fan and assembly using the 
instructions in the section Disassembling 
an Extruder and use a pair of pliers to 
remove the broken end of filament.

Extruder arms open

Extruder arms closed



Can’t unload filament?
If you cannot unload filament from one of 
the extruders, do the following:

1.   Go to the LCD panel and select Utilities 
> Filament Options > Unload. This option 
heats the extruders.

2.    Set the extruder lever arm to the  
open position.

3.   Push about half an inch of filament 
through the extruder. 

4.  Try pulling the filament out of the 
extruder again.

Extruder stays heated after loading or 
unloading filament?
If your extruder stays hot after loading 
filament or unloading filament, you  
might have enabled the Preheat option.  
To turn off the Preheat option, go to the 
LCD panel and select Preheat > Cool. This 
disables the heaters.

29STARTUP

TROUBLESHOOTING   CONTINUED

To disassemble an extruder:

1.  Unload the MakerBot Filament from the
extruder. To run the script for unloading 
filament, go to the LCD panel and select 
Utilities > Filament Options > Unload.

2.  Switch off the power on the MakerBot
Replicator 2X and unplug the power 
supply. Pull on the connector to release it 
from the power input port.

3.  Unscrew the two bolts at the lower corners
of the fan guard using your 2.5mm hex 
wrench. As one piece, remove the fan guard, 
the fan, the heat sink, and the spacers. Keep 
these pieces assembled and move them 
out of the way. 

4.  Unplug the motor wire harness from 
the top of the extruder motor and slide 
the motor assembly out of the extruder.

5.  The extruder is now broken down into 
its main assemblies. 

Disassembling an Extruder
Occasionally you may need to take an extruder apart for troubleshooting purposes. This is a 
simple process that will require no tools other than the 2.5 mm hex wrench you received with 
your MakerBot Replicator 2X. 



This chapter describes the menus and options available  
in the LCD panel on the MakerBot Replicator 2X.

LCD Menus

4
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LCD MENUS

THE LCD KEYPAD
The LCD Keypad includes four arrow buttons 
surrounding a central M button.

•   Use the arrows to navigate through 
the LCD menus and the M button to 
make selections.

•   The left arrow often allows you to go
back or cancel an action.

•   A solid red M means the MakerBot 
Replicator 2X is working. A blinking red 
M means the MakerBot Replicator 2X is 
waiting for user input.

TOP LEVEL ENTRIES
Before you have selected anything in the LCD 
panel, you will see these top-level menu entries:

Build from SD
This option allows you to print an X3G file 
from an SD card

•    Use the M button to select Build from SD. 
•    Use the up and down arrows to choose 

from the list of files on your SD card.
•    Press M to start a print. 
•    Select Exit Menu or the left arrow button 

to return to the top-level menu.

Preheat
To preheat your MakerBot Replicator 2X, 
select Preheat. Preheating reduces the 
amount of time it takes to heat the plate and 
extruders when you begin a print.

•   Choose the parts of the MakerBot 
Replicator 2X that you want to preheat. Use 
the arrow buttons to navigate to “Right Tool”, 
“Left Tool”, or “Platform”. Use the “M” button 
to toggle a setting between “ON” and “OFF”

For example, if you want to print with dual 
extrusion, set both extruders to ON.  If you are 
printing with ABS, set the platform to ON.

•   To start the preheat, use the up arrow and 
down arrow to choose “Start Preheat!” 
Select the M button to start the preheat.

•   If you need to stop the preheating process, 
just go to the Preheat menu again and use 
the up arrow or down arrow to choose “Cool!” 
Use the M button to turn off the preheat.

Utilities
The Utilities menu contains controls for 
your MakerBot Replicator 2X and scripts for 
processes like loading filament and leveling 
the build plate.

Info and Settings
The Info and Settings menu displays 
information about your MakerBot Replicator 
2X and allows you to change settings on your 
MakerBot Replicator 2X.
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THE UTILITIES MENU
The Utilities menu contains controls for 
your MakerBot Replicator 2X and scripts for 
processes like loading filament and leveling 
the build plate.

Monitor Mode. This entry displays the 
current temperature of your extruders and 
build plate. The display is updated as the 
temperatures change. 

Change Filament. This entry launches scripts 
that walk you through loading and unloading 
filament. See Help Text in the General 
Settings section below for information on 
how to make the scripts less verbose.

To stop any of the Change Filament scripts, 
press the left arrow button and select “Yes” 
when prompted.

Level Build Plate. This entry walks you 
through the process for leveling the build 
plate. The script moves the extruders to 
different points on the plate and prompts you 
to adjust the plate height at each point. 

To stop the Level Build Plate script,  
press the left arrow button and select  
“Yes” when prompted.

Home Axes. This entry moves your build 
platform and extruders to their default  positions.

Jog Mode. This entry allows you to change the 
position of the build platform and the extruders. 
[Fig. 4.2] Use the left and right arrows to select 
the X, Y, or Z- axis, the up and down arrows to 
move your extruders or build platform along 
the chosen axis, and the center button to exit 
Jog Mode. Jogging the Z-axis will move your 
platform up and down, and jogging the X and Y- 
axes will move your extruder right and left and 
backwards and forwards, respectively. 

Fig. 4.1

Fig. 4.2



Run Startup Script. This entry launches 
the startup script.  The Startup Script runs 
automatically the first time you power on the 
MakerBot Replicator 2X. The Startup Script 
walks you through the steps for leveling your 
build plate, loading filament into the right 
extruder, and printing from the SD card. To exit 
the Startup Script, press the left arrow button. 
You will not be able to exit the Startup Script 
until the leveling portion of the script begins.

Disable Steppers/Enable Steppers. This 
entry allows you to toggle on and off the 
stepper motors that move the extruders and 
build platform. If you need to manually move 
the build platform or the extruders, you must 
first disable the stepper motors. 

Blink LEDs/Stop Blinking. This entry allows 
you to toggle on and off blinking.  When toggled 
on, the LEDS in the MakerBot Replicator 2X will 
start blinking. When toggled off, the LEDs in the 
MakerBot Replicator 2X will stop blinking.

Calibrate Nozzles. This entry launches a 
script that allows the MakerBot Replicator 2X 
to correctly locate the two extruder nozzles. 
Use this script if your dual extrusion prints 
don’t appear to line up correctly on the plate. 
The script will print a series of lines with each 
nozzle and ask you to choose the ones that 
line up best. Your MakerBot Replicator 2X will 
store that information and use it to make your 
dual extrusion prints align better in the future. 

Exit Menu. This entry returns you to the  
top-level menu.

UTILITIES MENU CONTINUED
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THE INFO AND SETTINGS MENU
The Info and Settings menu displays 
information about your MakerBot Replicator 
2X and allows you to change settings on 
your MakerBot Replicator 2X. [Fig. 4.3]

Bot Statistics.  This entry displays the total 
build time, in hours and minutes, during 
the lifetime of your MakerBot Replicator 
2X. It also displays the duration of the last 
completed build. 

General Settings. This entry leads to a  
sub-menu that allows you to change settings 
on your MakerBot Replicator 2X. [Fig. 4.4]

To navigate the entries under General Settings:
• Use the up and down arrows to navigate

to the setting you want to change. 
• Use the M button to select the setting you

want to change.  
• Use the up and down arrows to scroll

through the available options for each setting.  
• Use the M button to select and confirm

your change to a setting.

Sound. This entry toggles the indicator sounds 
ON and OFF. Setting this entry to OFF stops 
the MakerBot Replicator 2X from beeping 
when you turn it on or when a print finishes.  
However, this option will not eliminate all 
sound made by your Replicator 2X.  The 
sounds you hear during printing come from the 
stepper motors and cannot be turned off. 

LED Color. This entry allows you to change 
the color of the LEDs in the frame of the 
MakerBot Replicator 2X. The LEDs can be set 
to WHITE, RED, ORANGE, PINK, GREEN, BLUE 
or PURPLE, or turned OFF.

Fig. 4. 4

Fig. 4. 3



Accelerate. This entry toggles acceleration ON 
and OFF. Acceleration is set to ON by default. 
Acceleration allows your MakerBot Replicator 
2X to operate more smoothly.  If you set 
Acceleration to OFF, do not use printing speeds 
faster than 45mm/s.

Heat Hold. This entry tells your MakerBot 
Replicator 2X to continue heating your 
extruders after a build is cancelled. You  
can set the hold time from one minute to 
thirty minutes. To turn this setting off, set 
it to zero minutes.

Help Text. This entry toggles verbose help 
text ON and OFF. Turning it ON provides 
verbose help text during scripts. Turning it OFF 
provides abbreviated help text during scripts.

Heat LEDs. This entry toggles heat indicators 
ON and OFF. When this entry is set to ON, the 
LED color will change from the default color 
to blue when the heating process begins and 
from blue to red when the extruders start 
to heat. When the MakerBot Replicator 2X 
reaches the target temperatures, the LED 
color returns to the default color. 

Tool Count. This entry displays the number of 
extruders your MakerBot has. The MakerBot 
Replicator 2X has DUAL extruders.

Heated Plate. This entry displays whether 
your MakerBot has a heated build plate.  
The MakerBot Replicator 2X has a heated 
build plate.

Exit menu. This entry returns you to the Info 
and Settings menu.

Preheat Settings. This entry lets you change 
the preheat temperatures for the extruders 
and build plate. Remember that that the 
temperatures are in degrees Celsius.

• Use the up and down arrows to navigate to
the setting you want to change (Right Tool, 
Left Tool, Platform)

• Use the M button to select the setting you
want to change.  

• Use the up arrow and down arrow to 
scrollthrough the available options 
for each setting.  

• Use the M button to select and confirm
your setting.

Version Number.  This entry displays the 
version number for the firmware on your 
MakerBot Replicator 2X.

Restore Defaults. This entry restores your 
MakerBot Replicator 2X to the default, 
factory settings. This option affects only 
settings that you can change through the 
LCD menus. Settings that you can change 
only using Makerware will not be restored.

Exit menu. This entry returns you to the  
top-level menu.

INFO AND SETTINGS MENU CONTINUED
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THE ACTIVE BUILD MENU
The LCD panel includes options and 
settings for use during printing. [Fig. 4.5]  
To access these settings during a print, 
select the left arrow. 

Pause. This entry allows you to stop a print 
briefly. During Pause, your extruders and build 
platform will not move from their current 
locations. Use Pause only to stop a print briefly. 
MakerBot does not recommend allowing a 
heated nozzle to remain stationary and in 
contact with your print for long period of time. 

Cancel Build.  This entry stops a build 
permanently. After you choose this option, 
you will be prompted to confirm that you 
want to cancel the build. 

Change Filament. This entry allows you to 
move the extruders away from your print, 
change filament, and then resume the print. 
This entry is useful for printing multi-colored 
objects or for changing an empty spool of 
filament. After you change the filament, select 
the left arrow button to return to the Active 
Build menu. Select the entry for Resume Print.

Sleep (Cold Pause)/Resume Build. This 
entry allows you to pause a print for long 
periods of time. When you select this option, 
your Replicator 2X will complete any queued 
commands before moving the extruder away 
from your print and allowing the extruders and 
build plate to cool. During a cold pause, the 
menu option will change to Resume Build. 
Press M to resume printing. 

ACTIVE BUILD MENU
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Z Pause Height. This entry allows you 
to pause your print at a set height. When 
you select this option, you will see two 
additional settings: Z Position and Pause 
Active. [Fig. 4.6] To set the pause height, 
scroll to Z Position, press the M button, and 
use the arrows to increase the pause height 
in millimeters. Press the M again to confirm 
the height. Scroll to Pause Active and use 
the M button to toggle the setting ON and 
OFF. When Pause Active is set to ON, a Z 
height pause will be triggered, even if the Z 
Position is set to 0. 

Filament Fan. This entry allows you to set an 
active cooling fan to ON or OFF during a build. 
The MakerBot Replicator 2X does not include 
an active cooling fan.

LED Color. This entry allows you to change 
the color of the LEDs in the frame of the 
MakerBot Replicator 2X. The LEDs can be 
set to WHITE, RED, ORANGE, PINK, GREEN, 
BLUE or PURPLE, or turned OFF. Use the up 
arrow and down arrow to scroll through the 
available colors. Use the M button to select 
and confirm your selection.

Build Statistics. This entry displays the 
elapsed time for the current build and the line 
number of the command being executed by 
your Replicator 2X. [Fig. 4.7]

Back to Monitor. This entry returns you 
to the Monitor screen. The Monitor screen 
displays the percent of the print that has been 
completed and the temperatures of the Right 
Extruder, Left Extruder, and Platform.

ACTIVE BUILD MENU CONTINUED
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Your MakerBot Replicator 2X includes an installed SD card.  This card 
contains sample objects so you can start printing immediately.
This chapter will walk you through the steps to print sample objects.

Printing from SD

5
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LOCATE THE SD CARD
The MakerBot Replicator 2X includes an SD 
card preloaded with files for making test 
objects. The SD card is located in the SD port, 
directly behind the LCD panel. Make sure the 
SD card is pushed firmly into the SD port.

SELECT A PROJECT FROM THE SD CARD
The final task in the Startup Script is to print 
an object from the SD card. After you have 
successfully leveled the build plate and 
loaded the MakerBot ABS Filament  into the 
right extruder, the LCD panel will ask you: 
“How’d it go? Ready to make something?” 
Select “Yes” and the LCD panel will display: 
“Awesome! We’ll go to the SD card menu 
and you can select a model!”

If you want to print from the SD card but are 
not running the Startup Script, use the LCD 
panel to navigate back to the top-level menus.  

1.   Select Build from SD.

2.   Use the arrow keys to navigate through 
the list of models available. The models 
come pre-loaded on your SD card are 
also shown on the following page of  
this manual.

3.  To select a model, press M.

4.  The MakerBot Replicator 2X will begin to
make your object. You can use the LCD
panel to monitor the temperature of the 
extruders and build plate and the status 
and progress of your object.

MAKING A TEST OBJECT FROM THE SD CARD

EXAMPLE: PRINTING THE CHAIN LINKS
In this section, we will print the chain links 
object from the SD card.  To do this:

1.  On the LCD panel, navigate back to the 
top-level menus. Select Build from SD.

2.  Use the arrow keys to navigate through 
the list of models on the SD card. Find 
the chain links model.

3.  To choose the chain links, press M. 

4.  The MakerBot Replicator 2X will begin to
make your object. Once the build plate and
extruders have reached their target
temperatures, the print will take about 12
minutes. You can use the LCD panel to
monitor the temperature of the extruders
and build plate and the status and progress
of your object.
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MAKING A TEST OBJECT FROM THE SD CARD   CONTINUED

CHAIN LINKS
File Name: Chain Links
Make Time: 12 Minutes

Design By: Sal
Thingiverse:    28405

NUT AND BOLT SET
File Name: Nut and Bolt
Make Time: 27 minutes

Design By: aubenc
Thingiverse:    9095

COMB
File Name: Comb
Make Time: 14 Minutes

Design By: repraprook
Thingiverse:    1140

STRETCHY BRACELET
File Name: Stretchlet
Make Time: 16 minutes

Design By: Emmett
Thingiverse:    13505

MR JAWS
File Name: Mr Jaws
Make Time: 18 minutes

Design By: Mahoney
Thingiverse:    14702

CUPCAKE
File Name: Cupcake
Make Time: 52 minutes

Design By:      Will Langford
Thingiverse:    16824

*

* Dual extrusion prints require two colors of MakerBot ABS filament loaded into your 

MakerBot Replicator 2X.

PET MONSTER VALENTINE
File Name: Heartless Dragon
Make Time: 40 minutes

Design By: andreas, tbuser
Thingiverse:    29088

*

TRAFFIC CONE
File Name:   Traffic Cone
Make Time: 42 minutes

Design By: CocoNut
Thingiverse:    21773

*

MAKERBOT PENDANT
File Name: pendant
Make Time: 8 minutes

Design By: Todd
Thingiverse:    25556

*
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TROUBLESHOOTING

The Replicator 2X doesn’t recognize  
the SD Card
If your MakerBot Replicator 2X does not 
detect that there is a card in the SD slot, 
make sure the SD card is:

•   an SDSC card formatted for FAT16  
•   no larger than 2GB.

Your MakerBot Replicator 2X can read only 
cards that meet these requirements. 

The default SD card that is shipped with 
your MakerBot Replicator 2X is formatted 
correctly and is of the correct size. 

If the card is formatted correctly but your 
MakerBot Replicator 2X fails to recognize 
it, something may be wrong with the card. 
Contact MakerBot Support.

The Replicator 2X doesn’t see the files  
on the SD Card
If your MakerBot Replicator 2X detects 
the SD card but can’t see the files on the 
SD card, make sure that each file is in the 
correct format. 

Your MakerBot Replicator 2X can  
read only files:

•   that use the X3G format. To create an X3G 
file in MakerWare, click Export to File in 
the make dialog and select X3G from the 
file type dropdown menu. 

•   with files name fewer than 26 characters;
30 characters if you count the file 
extension.  If you are trying to print an  
X3G file with a  long file name, shorten  
it and try again.

The default SD card that is shipped with 
your MakerBot Replicator 2X contains only 
files of the correct format and with names 
less than 26 characters.  

If the files are formatted for X3G and the 
file names have fewer than 26 characters 
but your MakerBot Replicator 2X fails to 
recognize them, something may be wrong 
with the card. Contact MakerBot Support.

Printed objects don’t stick to the build plate
If printed objects are not sticking to the 
build plate, try these solutions:

•   Re-level your build plate by going to 
Utilities > Level Build Plate. Inconsistent 
plate height will lead to inconsistent 
adhesion. If any one part of your object 
does not adhere well to the plate, the 
whole object might peel off the plate. 
Try leveling the plate again and using 
a thinner piece of paper or feeler gauge 
to check the distance.

•   Ensure that the plate is clean. Bubbles, 
scratches, dust, and oil from your hands 
can prevent objects from sticking to the 
Kapton tape. Wipe down the build plate 
with a clean, lint-free cloth.



This chapter describes the different types of files you will encounter while 
using your MakerBot Replicator 2X. STLs, OBJs and Things are ways to store 
3D models. GCode and X3G are sets of instructions for your MakerBot.

File Types
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STL
An STL is a widely used type of 3D model 
file. It consists of surfaces made up of 
triangles. Each triangle has an inner side 
and an outer side. The outer side is called 
the normal. In a well-formed STL, all the 
normals face outwards and the surface is 
continuous, with no holes. When a model 
meets these standards, it is referred to 
as manifold. STLs with normals that 
face inwards (inverted normals) may 
be printable, but a manifold model is 
considered a prerequisite for 3D printing. 

STLs are compatible with many different 3D 
modeling programs and have become the 
standard file type for 3D printable models. 
SolidWorks®, Rhinoceros®, and most 
Autodesk® programs will export STL files, 
and there are free plugins available that will 
allow you to export STLs from SketchUp®.

OBJ 
An OBJ is another type of 3D model file. It 
is also used by a number of 3D modeling 
programs, but is used for 3D printing less 
often than STL. Unlike STLs, where every 
facet of your 3D model is a triangle, an OBJ 
can contain triangles and other polygons. 
Rhinoceros and some Autodesk programs 
will export OBJ files, but other programs, 
including SketchUp and SolidWorks, will 
require a plugin to export as OBJ.

THING
A Thing file allows you to save build plates 
in MakerWare. The file includes information 
about the orientation and position of any 3D 
model on the plate. The file also allows you 
to include multiple models on the plate. 

When you plate multiple models and save 
them as an STL, you will no longer be able 
to move the individual models in relation to 
each other. When you save multiple models 
in a Thing file, you can continue 
 to manipulate them individually.

The Thing format works only with MakerWare, 
so you should not save as Thing if you are 
saving a file for use with another program.

If you have a Thing file and need to edit  
the individual STL files, you can change  
the file extension to .zip, unzip the file  
and extract the STLs.

GCODE
GCode is a computer language for 
controlling CNC machines, including 
many 3D printers. When your slicing 
software turns your 3D model into a set 
of instructions for your MakerBot, those 
instructions are written in GCode. The 
instructions consist of commands that 
tell the extruders how hot to get, where to 
move and when to start extruding plastic, 
commands that control the build platform 
and  commands for peripheral components, 
including the LEDs inside your MakerBot.

Before being sent to your MakerBot, 
MakerWare converts the human-readable 
GCode to the more compact, computer 
readable X3G. You can’t edit X3G files,  
but you can edit GCode to do things like 
change extrusion temperatures and insert 
extra commands. 

FILE TYPES



MakerWare automatically converts GCode 
to X3G when sending a file to your printer 
or saving to an SD card. To view the GCode, 
open the Make dialog and make sure it is set 
to Export to a FiIe. When the Export dialog 
appears, select GCode from the dropdown 
menu at the bottom of the window. You can 
open your GCode file in any text editor. 

To print from saved or edited GCode, go to the 
MakerWare File menu at the top of the screen 
and choose Make from File… Navigate to the 
GCode file and choose Open. For more details 
on printing from GCode, see Chapter 8. 

X3G
X3G is the compact format in which 
MakerWare sends instructions to your 
MakerBot. An earlier version of this  
format was called S3G. X3G files are 
currently generated only by MakerWare  
and ReplicatorG.

FILE TYPES CONTINUED
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MakerBot MakerWare is software that prepares 3D models for printing 
and turns them into instructions for your MakerBot Replicator 2X. Using 
MakerWare, you can prepare OBJ and STL files to be printed. You can also 
use MakerWare to customize print settings for the objects you make on 
your Replicator 2X.

 
MakerWare
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DOWNLOADING AND INSTALLING MAKERWARE

TROUBLESHOOTING

1. Go to http://makerbot.com/makerware. 

2. Choose your operating system from the 
platform drop-down menu. [Fig. 7.1]

3. Click the Download button and save the 
.exe or .dmg file to your local computer.

4. Open the saved file and follow the 
directions to install the MakerWare software.

NOTE: During Windows installation, a separate 

installer window will open and  prompt you to 

install device drivers.

Cannot install MakerWare
Perform the installation steps again. If the 
installation fails a second time, collect as 
much information on the failure as you 
can and open a support ticket by emailing 
support@makerbot.com. MakerBot Support 
will work with you to diagnose the issue.

Computer displays security warnings  
during installation
Your operating system may not recognize 
the drivers MakerWare is installing because 
they are specific to MakerWare and to your 
MakerBot Replicator 2X. Click OK to allow 
the device drivers to install.

SELECTING YOUR MAKERBOT 
REPLICATOR 2X
If you connect your MakerBot Replicator 2X to 
your computer before you start MakerWare, 
MakerWare will automatically detect your 
MakerBot Replicator 2X. The icon in the lower 
right corner will display “The Replicator 2X.”

If you start MakerWare before you connect 
your MakerBot Replicator 2X to your 
computer,  MakerWare will display a 
welcome message and ask you to choose 
your bot from a dropdown menu. Choose 
Replicator 2X and click Let’s Get Started!

If MakerWare defaults to the incorrect type 
of MakerBot 3D printer:

1. Open the MakerBots menu.

2. Choose Type of MakerBot.

3. Choose The Replicator 2X.

MakerWare will display settings and options 
appropriate for the MakerBot Replicator 2X

Fig. 7.1



Open MakerWare and take a look around. The following buttons and menus appear:

48

EXPLORING MAKERWARE

HOME VIEW 

Click this button to reset MakerWare to the 
default view of the build area.

+/-
Click these buttons to zoom in and out.  
You can also use the scroll wheel on  
your mouse to zoom in and out.

Fig. 7.2



LOOK [Fig. 7.3]
Click the Look button or press the L key to 
enter Look mode. In Look mode, you can:

•   Left-click and drag the mouse to rotate
your view of the object. 

•   Hold down shift, left-click, and drag the
mouse to move your view of the object.

•   Click on the Look button again or press 
the L key to view the Change View submenu. 

Top: View the object from the top.

Side: View the object from the side.

Front: Default view. View the object from 
the front side.

Reset View: Returns to the default view.

MOVE [Fig. 7.4]
Click the Move button or press the M key to 
enter Move mode. In Move mode, you can:

•   Left-click and drag the mouse to move 
the object. 

•   Hold down shift, left-click, and drag the
mouse up and down.

•   Click the Move button again or press the M 
key to view the Change Position submenu.

X: Specify position left and right, in millimeters.
Y: Specify position forward and backward, 

in millimeters.
Z: Specify position up and down, in millimeters.

On Platform: Moves the object to a Z 
position of 0.00mm.

Center: Centers the object on the build plate. 

Reset Position: Returns the object to the 
last saved position on the build plate. 
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TURN [Fig. 7.5]
Click the Turn button or press the T key to 
enter Turn mode. In Turn mode, you can:

•  Left-click and drag the mouse to rotate the
object around (0, 0, 0) the X,Y, and
Z-axes.

•  Click the Turn button again or press the T 
key to view the Change Rotation submenu.

X: Specifies rotation around the X-axis, 
in degrees.

Y: Specifies rotation around the Y-axis, 
in degrees.

Z: Specifies rotation around the Z-axis, 
in degrees.

Reset Rotation. Resets the rotation 
around (0, 0, 0).

Reset Scale. Resets the object to the last 
saved scale.

SCALE [Fig. 7.6]
Click the Scale button or press the S key to 
enter Scale mode.  In Scale mode, you can:

•   Left-click and drag the mouse to change the
scale of the object. 

•   Click the Scale button again or press the S key 
to view the Change Dimensions submenu.

X:  Specifies size along the X-axis, in millimeters.
Y: Specifies size along the Y-axis, in millimeters.
Z:  Specifies size along the Z-axis, in millimeters.

Uniform scaling. Maintains the proportions  
of the object.  If you change a dimension,  
the other two dimensions maintain their 
relative size.

Inches -> mm. Converts a model that has 
been sized in inches to millimeter scale.

EXPLORING MAKERWARE CONTINUED
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Maximum size. Changes the scale of the 
object to the maximum that can be printed 
by the MakerBot Replicator 2X.

Reset Scale. Resets the object to the last 
saved scale.

OBJECT [Fig. 7.7]
Click twice to open the Object Information 
submenu. The Object Information submenu 
allows you to choose which extruder will print 
each object on your build plate. For details on 
printing objects with dual extrusion, see the 
chapter on Basic Printing.

ADD
Click this button to add an object to your 
build plate. When you select the Add button, 
you can browse for STL and OBJ files on 
your local computer. You can add as many 
objects as you can fit on the plate.

MAKE
Click this button to open the Make dialog, 
where you can specify print resolution and 
other printing options and save instructions for 
your MakerBot Replicator 2X to an SD card. For 
details on the Make dialog, see the chapters on 
Intermediate and Advanced Printing.

SAVE
Allows you to save the current plate as a file 
for later use.

HELP
Opens a guide to MakerWare’s basic functions.

STATUS BAR
Displays the status of your connection to 
your MakerBot Replicator 2X. 

EXPLORING MAKERWARE CONTINUED
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FILE
New: Opens a new MakerWare window.

Open: Opens a new object file. If a file is 
currently open, you will be prompted to 
save it first.

Add: Adds a new object to the current plate.

Recent: Displays a list of recently opened files.

Examples: Provides a list of example files 
to print.

Close: Closes MakerWare without saving.

Save: Saves changes to the current plate.

Save As: Saves the current plate as a .thing 
file or a .stl file.

Export: Saves the current plate as a  
GCode or .x3g file.

Make: Displays the Make dialog.

Make from File: Prints or exports from
.gcode file to X3G file.

EDIT
Undo:  Undoes the last action.

Redo: Redoes the last action.

Cut: Cuts object.

Copy: Copies object.

Paste: Pastes object.

Delete: Deletes selected object.

Select All: Selects all objects.

Deselect All: Deselects all objects.

Auto Layout All:  Performs auto layout  
of all objects.

Settings:  Opens a menu that allows you 
to assign a display color to each extruder. 
On a Mac, access this menu by going to 
MakerWare > Preferences.

VIEW
Home View: Displays a view of the front and 
top of the object.

Top View: Displays a view of the top of  
the object.

Side View: Displays a view of the right side 
of the object.

Front View: Displays a view of the front of 
the object.

MAKERWARE MENUS
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MAKERWARE MENUS CONTINUED

MAKERBOTS
Upload Firmware: Checks for the latest 
version of the firmware. Prompts you to upload 
the latest if the firmware is out of date.

Onboard Preferences: Allows you to 
change the default settings for the MakerBot 
Replicator 2X. For advanced users.

Type of MakerBot: Allows you to specify the 
type of MakerBot Replicator you are using 
during the session.

SERVICES
Stop Background Service:Stops Conveyor, 
the service that manages print jobs and  
connections to the MakerBot Replicator 2X.

Start Background Service: Starts 
Conveyor, the service that manages print 
jobs and connections to the MakerBot  
Replicator 2X.

Show Background Service Log: Displays a 
log file for the current Conveyor session.

HELP
Quick Help:  Opens a guide to MakerWare’s 
basic functions.

Online Help:  Displays information   
from the MakerBot website.
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SELECTING AN OBJECT
•   To select a single object, left-click with the mouse.
•   To select two objects, select one object, hold down the Shift key and select the other

object. Release the Shift key.
•   To select multiple objects, select one object by clicking with the left mouse button, hold

down the Shift key, select additional objects, and release the Shift key. 

SHORTCUT KEYS

L Enters Look mode

M Enters Move mode

T Enters Turn mode

S Enters Scale mode

O Enters  Object mode

Ctrl/Cmd +N Opens an additional MakerWare window

Ctrl/Cmd + O Opens a new object file. If a file is currently open, you will be 
prompted to save it first

Ctrl +F4 (Windows)
Command+Q (Mac)

Closes MakerWare

Ctrl/Cmd +S Saves the current plate

Ctrl/Cmd +P Displays the Make dialog

Ctrl/Cmd +Alt+P Displays the Make From File window

Ctrl/Cmd +Z Undoes last action

Ctrl +Y (Windows)
Command+Shift+Z 
(Mac)

Redoes last action

Ctrl/Cmd +X Cuts object

Ctrl/Cmd +C Copies object

Ctrl/Cmd+V Pastes object

Ctrl/Cmd+D Duplicates selected object

Delete Deletes object

Ctrl/Cmd+A Selects all objects

Ctrl/Cmd+Shift+A Deselects all objects

Ctrl/Cmd+L Performs auto layout of all objects

Ctrl/Cmd+1 Returns to Home view

SHORTCUT KEYS
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TROUBLESHOOTING

MakerWare cannot detect my MakerBot 
Replicator 2X
When MakerWare cannot connect to the 
MakerBot Replicator 2X, that usually means 
you have to restart Conveyor. Conveyor is 
a background service that runs as part of 
MakerWare and manages the connection to 
your MakerBot Replicator 2X. 

To restart Conveyor:
1.   Go the Services menu.
2.   Choose Restart Background Service.
3.   If Conveyor was the cause of the problem, 

you should now see the Replicator 2X icon at 
the lower right of the MakerWare window.



MakerWare allows you to open files, resize objects, create new object 
files, and save those files in multiple formats.  This chapter will describe 
how to perform these tasks.

Preparing 
to Print

8



DOWNLOADING A FILE FROM THINGIVERSE
To import a file from Thingiverse into 
MakerWare, you must first save the file to 
your local computer. In this example, we will 
import two files from Thingiverse: FlatIron.stl 
and Woolworth.stl. To do this: 

1. Open a browser session and go to  
http://www.thingiverse.com. 

2. If you know the name of the file you want 
to import, you can use the Search field in the 
upper right of the page. Use the search field 
at the upper right to search for “Minimalist 
NYC buildings.” Your search results should 
include “Minimalist NYC buildings by 
JonMonaghan.” Click on the link. [Fig. 8.1]

3. At the right of the page you will see a 
button that says “Download This Thing!” [Fig. 
8.2] Click this button to open the Downloads 
window.

4. For this example we chose the Flatiron 
Building and the Woolworth Building. In 
the Downloads window, find FlatIron.stl and 
Woolworth.stl and click the file names to save 
them to your computer. 

DOWNLOADING FILES
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FILE FORMATS FOR MAKERWARE
MakerWare can open the following  
file types:

•   OBJ
•   STL
•   THING

MakerWare can save the following  
file types:

•   STL
•   THING

MakerWare can export to the following  
file types:

•   GCode
•   X3G
•   S3G

For details on file types, see the chapter 
titled “File Types.”

Fig. 8. 1

Fig. 8. 2
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The files FlatIron.stl and Woolworth.stl are 
now ready to be opened in MakerWare. The 
following examples will make use of these 
two files. 

IMPORTING A FILE FROM  
A MODELING APPLICATION
To import a file from a 3D modeling 
application into MakerWare:

1.  In the 3D modeling application, save the 
file as either a binary STL file, an ASCII 
STL file, or an OBJ file.

2. Start MakerWare.  Choose the File menu. 
Choose Open. Navigate to the directory 
where you stored the file from the 3D 
modeling application.

3. Select the file and click Open to open 
the file in MakerWare.

MOVING AN OBJECT [Fig. 8.3]
In this section, we will open a file and move 
the object.

1.  Start MakerWare. Choose the File menu. 
Choose Open. Navigate to the directory 
where you stored FlatIron.stl.  Select this file 
to open it.

The Flatiron model appears in the middle of 
the plate in MakerWare.

2. To move the model around on the plate:

•   Click on the Move button. 
•   Hold down the left mouse button and drag 

left, right, forward, and back. 
•   Hold down shift and the left mouse 

button and drag up and down
•   Click on the Move button again or 

press the M key to view the Change 
Position submenu.

IMPORTING AND MOVING OBJECTS

Fig. 8. 3



3.  To prepare for the next section, move 
the Flatiron model to the left side of  
the build plate.

DUPLICATING OBJECTS [Fig. 8.4]
In this section, we will copy an object.

Currently, you should have the Flatiron model 
at the left side of your build plate. We will 
make a copy of the Flatiron model. To do this:

1. Click on the Flatiron model.  A yellow 
outline will surround the object.

2.  Press the keys Ctrl+C or Command+C to 
copy the file.  

3.  Press the keys Ctrl+V or Command+V to 
paste a copy of the file onto the plate.  
The copy of the Flatiron model will 
appear right next to the original.

4. Press the keys Ctrl+Z or Command+Z to
undo your last action and remove the
copy of the Flatiron model.

COPYING OBJECTS
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ADDING AN OBJECT TO THE PLATE
In this section, we will add a second object 
to the plate.

Currently, you should have the Flatiron 
model at the left side of your build plate. 

1. Click the Add button. 

2. Navigate to the location of the file 
Woolworth.stl and select that file. 

Now you should see both the Flatiron 
Building and the Woolworth Building models 
on the plate in MakerWare.

You can manipulate the models on the plate 
separately or together. 

MANIPULATING MULTIPLE OBJECTS
1. To manipulate one object, select only that 
object.  For example:

•   Select the Flatiron model.
•   Click the Turn button.  
•   Hold down the left mouse button and 

use your mouse to rotate the object.
Notice that only the selected object, the 
Flatiron Building model, rotates.

2. If you select more than one object, 
you can apply the Move function, Turn 
function or Scale function to those 
objects simultaneously. For example:

•   Select the Flatiron Building.
•   Hold down the Shift key and select the 

Woolworth Building. Then release the 
Shift key. Both models should be selected.

•   Select the Turn button.  
•   Hold down the left mouse button and 

drag to rotate the models. Notice that 
both objects rotate.

SCALING AN OBJECT
In this section, we will scale our two models.

Currently, you should have the Flatiron and 
Woolworth models on your plate.

1. Select the Flatiron model.

2. To scale the Flatiron model:

•   Click the Scale button. 
•   Hold down the left mouse button 

and drag to change the scale of  
the object. 

•   Click on the Scale button a second time 
or press the S key to view the Change 
Dimensions submenu.

3. Click Reset Scale to return the Flatiron
model to its original scale.

4. Select the Flatiron model, hold down the
Shift key and then select the Woolworth 
model.  Both objects should now be selected.

5. Use the Scale button to change the scale.
Notice that both objects are re-scaled 
simultaneously, while maintaining the 
relative scale.

ADDING AND SCALING OBJECTS
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SAVING AND PRINTING A FILE

SAVING YOUR MODEL AND   
TOOLPATH FILES
To save an object or a plate with multiple 
objects, click the Save button. 

The Save dialog gives you the option to save 
the contents of the build plate as an STL or 
Thing file. 

•   If you want to open the file in an application 
other than MakerWare, you should save the 
file as an STL file.  If you save as an STL file, 
you can no longer manipulate each object 
separately in MakerWare.

•   If you save as a Thing file, you will be 
able to open the file in MakerWare and 
manipulate each object independently.  
However, Thing files can be opened only 
with MakerWare.

NOTE:  You can always change the file type by 

opening the file in MakerWare and saving it again as 

a different file type.

PRINTING YOUR FILE
1.  Insert your SD card into an SD card reader

attached to your computer.

2 . Click the Make button. 

3.  Accept the default settings and click the
Export! Button. MakerWare will open the
Export dialog. 

4.  Set the following options in the Export
dialog:

• Navigate to the location of your SD card 
and select it.

• Enter “flatiron_woolworth” as the file name.
• Ensure that X3G is selected from the file 

type dropdown menu.

5.  Click Save. 

6.  Eject your SD card from your computer’s
SD card reader and insert it into the SD 
card port behind the MakerBot Replicator 
2X’s LCD interface.

7.  Use the arrow buttons on the LCD
interface’s keypad to navigate to “Build 
from SD”. Press the M button to view the 
list of files available on your SD card.

8.  Use the arrow buttons to navigate to the
file flatiron_woolworth.x3g. Press the M
button to build the selected file. Your
MakerBot Replicator 2X will use the
toolpath you created to build your model.



This chapter will walk you through printing two objects using the default 
settings in MakerWare.  It will also walk you through the steps to print a 
dual extrusion object. 

This chapter assumes you have already downloaded and installed 
MakerBot MakerWare. If you have not installed MakerWare yet,  see the 
chapter on Installing MakerWare.

Basic Printing
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PRINTING THE OWL STATUE
To print this owl model, we will download 
the STL file from Thingiverse and then open 
and print the file with MakerWare.

The default size of this model is quite large, 
so we will make use of the scaling feature 
to resize it. Scaling down the owl model will 
also reduce the printing time.

1. Open a browser session and go 
to http://www.thingiverse.com. 

2. In the Search field in the upper right 
of the page, enter “Owl statue”.

3. In the Search Result page, find Owl 
statue by cushwa. Click on the title link.

PRINTING EXAMPLES
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PRINTING THE TREE FROG
To print this tree frog model, we will 
download the STL file from Thingiverse and 
then open and print the file with MakerWare. 
It is a simple design and does not need any 
adjustments made to it in MakerWare.

1. Open a browser session and go to 
http://www.thingiverse.com. 

2. In the Search field in the upper right of the
page, enter “treefrog”.

3. In the Search Result page, find Treefrog by
MorenaP. Click on the title link.

4. On the Thing page for the tree frog model,
you will see a button that says Download 
This Thing! Click this button.

5. In the Downloads window, in the Filename
pane, select the file treefrog_45_cut.stl.
Thingiverse will download the file to your
local computer.

6. Start MakerWare. Choose the File menu.
Choose Open. Navigate to the directory 
where you stored the file treefrog_45_cut.stl. 
The tree frog  should appear 

in MakerWare.

7. Click the Make button.

8. In the Make dialog, select the Export 
to File radio button. [Fig. 9.1]

9. Click the Export! button. A dialog box will
open asking you to save the STL file. Ensure 
that you have chosen X3G in the file type 
drop-down menu. Save the file to an SD card.

10. Eject the SD card from your computer and
insert it into the SD port on your MakerBot 
Replicator 2X.  Choose Build From SD from 
the LCD menu,  and select the Tree Frog.

Fig. 9.1



4. On the Thing page for the Owl statue, 
you will see a button that says Download 
This Thing! Click this button.

5. In the Downloads window, select the 
button Download All Files. Thingiverse 
will download the file OwlReDo1_fixed_sc.stl 
to your local computer.

6.  Start MakerWare. Choose the File menu. 
Choose Open. Navigate to the directory 
where you stored the file OwlReDo1_fixed_
sc.stl. The owl should appear in MakerWare.

7.  Click the Scale button twice. In the 
Change Dimensions dialog, edit the 
following settings: 

Uniform scaling:  Ensure that this checkbox 
is selected.

X: Set this field to 40.00mm. [Fig. 9.2]

8. To save your changes, go to the File 
menu and choose Save.

9. Choose the File menu and choose Make 
or click the Make button.

10. In the Make dialog box, select the Export
to a File radio button.

11. In the Make dialog box, click the Export!
button. Save your STL file to an SD card.

PRINTING A DUAL EXTRUSION OBJECT
Dual extrusion models are composed of two 
STL files sliced to a single X3G file where 
one of the STL files will be printed by the 
left extruder, and the other STL file will be 
printed by the right extruder.

PRINTING EXAMPLES CONTINUED
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To better understand how dual extrusion 
works, we will download a dual extrusion 
object from thingiverse.

1. Open a browser session and go to 
http://www.thingiverse.com. 

2. In the Search field in the upper right of the
page, enter “Lotus Flower”.

3. In the Search Result page, find Lotus
Flower by rweaving. Click on the title link.

4. In the Thing page for the Lotus flower, you
will see a button that says Download This 
Thing! Click this button.

5. In the Downloads dialog box, select the
button Download All Files. Thingiverse  
will download the files Lotus_color1.stl  
and Lotus_color2.stl to your local computer.

6. Start MakerWare. Ensure you have
Replicator 2X selected. To do this:

•   Go to the MakerBots menu. 
•   Choose Type of  MakerBot. 
•   Choose The Replicator 2X.

7.  Choose the File menu. Choose Open. 
Navigate to the directory where you stored 
the file Lotus_color1.stl. The Lotus Flower 
should appear on the plate in MakerWare.

8.  Click the Add button. Navigate to where 
you stored the file Lotus_color2.stl.

9.  MakerWare displays a dialog asking 
“This object is off the platform. Do you want 
to put it on the platform?”. Select “Keep 
Position”. MakerWare will position the new 
object on top of the existing object. [Fig. 9.3]

PRINTING WITH BOTH EXTRUDERS
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10.  Click on the point of an outer petal from 
the first layer to highlight that object.

11.  Click twice on the Object button.

12.  In the Object Information submenu, in 
the Extruder field, select an extruder to 
print Lotus_color1.stl. [Fig. 9.4]

13.  Click on the point of an outer petal from 
the second layer to highlight that object. 

14.  Click twice on the Object button.
 
15.  In the Object Information submenu, 

in the Extruder field, select an extruder 
to print Lotus_color2.stl.

16.  To keep the two STL files linked together 
and assigned to extruders, save the 
object as a .thing file. To do this:

•   In the File menu, choose Save As.
•   Save the file as a .thing file.

17.  Choose the File menu and choose Make
It or click the Make button.

18.  In the Make dialog box, select the Export
to a File radio button.

19.  In the Make dialog box, click the Export!
button. Save your STL file to an SD card.

PRINTING WITH BOTH EXTRUDERS CONTINUED
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This chapter is for users who are ready to start editing print settings in 
MakerWare instead of accepting the default settings. It will explain when 
and how to use helper disks with a print, when and how to use rafts and 
support with a print, and how to use the print quality settings in the Make 
dialog in MakerWare.

Intermediate 
Printing
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PRINT QUALITY
In MakerWare, when you select the Make 
command or Make button, you can specify 
one of three preset printing profiles. 
[Fig 10.1] Your choices are:

•   Low. Prints an object with lower 
resolution, but with a shorter print time.

•   Standard. Prints an object with 
standard resolution.

•   High. Prints an object with higher 
resolution, but with a longer print time. 

The setting that most affects print quality 
is layer height. The preset layer heights in 
MakerWare range in size from 0.10 mm to 
0.30 mm. The thinner the layer, the more 
layers per millimeter and the smoother the 
texture of your printed object.  

The Low, Standard and High profiles in 
MakerWare support and optimize different 
layer heights. [Fig 10.2] When you select a 
printing profile in the Make dialog, you are 
choosing both a layer height and a slicing 
profile that will work best with the selected 
level of resolution. For more on slicing 
profiles, see http://www.makerbot.com/
support/makerware/documentation/slicer/.

Quality Infill Number 
of Shells

Layer 
Height

Low 10% 2 0.30 mm

Standard 10% 2 0.20 mm

High 15% 2 0.10 mm

Fig. 10.1

Fig. 10.2



RAFTS 
A raft is a flat base that is printed before 
the object. A raft can help your object stick 
securely to the build plate. [Fig 10.3]
 
In MakerWare, when you select the Make 
command or Make button, you can check a 
box in the Make dialog to include a raft with 
your print. 
 
A raft consists of several layers forming 
a flat surface for your object to rest on. 
Objects printed with rafts sit on this base 
of disposable material instead of directly 
on the build surface. If your build plate is 
uneven or has imperfections, the raft might 
provide a better build surface. The base 
layer of the raft is thicker than a regular layer 
and prints more slowly, so it adheres better 
to the build plate.

NOTE: MakerBot recommends that you include 

a raft for best results when printing with support. 

Support structures might not adhere well to the 

build plate without a raft.

To print an object with a raft:

1.  Open MakerWare. Open the model you 
want to print. 

2.  Click the Make button or open the File 
menu and choose Make It.

3.  In the Make dialog, make sure the Raft 
box is checked. 

4. Print the object as usual.

RAFTS
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File Name: 3D mouse Fig. 10.3

Design by: DDStarkey

Thingiverse: 61909



In MakerWare, when you select the Make 
command or Make button, you can check a 
box in the Make dialog to specify whether 
your object will include automatically 
generated support structures. 

Supports allow you to print overhanging parts. 
Because the MakerBot Replicator 2X cannot 
print into thin air, supports provide a base for 
overhanging parts of a model. You can easily 
remove supports after building the object.

For an example, look at this bird model 
designed by Scintilla. [Fig 10.4]

The thin legs provide almost no support for 
the body, so it will not print correctly without 
added support material.  

Remove support material by tearing it away 
with a pair of pliers or your fingers.
Supports can leave surface imperfections 
that require finishing of the object. For 
details on finishing an object, see the 
chapter titled “Finishing Things”.
 

SUPPORTS
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SUPPORTS

The Raft Won’t Come Off My Object
If you can’t easily remove the raft from your 
object, try these solutions:

•  Create or edit a custom profile using 
the MakerBot Slicer and increase the 
“raftModelSpacing” setting by .1 mm. This 
will increase the separation between the 
raft and the model.

•  Create or edit a custom profile using 
the MakerBot Slicer and increase the 
“feedstockMultiplier” by .05 mm. The raft 
might be difficult to remove because too 
much plastic is being extruded. Changing 
this setting will slightly decrease the 
amount of plastic extruded.

For information on creating and 
editing custom profiles, see our online 
documentation at makerbot.com/support/
makerware/documentation/slicer.

File Name:  Bird (for putting on things) Fig. 10.4

Design by: scintilla

Thingiverse: 76469

Fig. 10.5
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The Supports Won’t Come Off My Object
•   Create or edit a custom profile using

the MakerBot Slicer and increase the 
“supportMargin” setting by .1 mm. This 
will increase the separation between the 
support structures and the model.

•   Create or edit a custom profile using the
MakerBot Slicer and increase the
“feedstockMultiplier’’ by .05 mm. The 
supports might be difficult to remove 
because too much plastic is being 
extruded. Changing this setting will slightly 
decrease the amount of plastic extruded.

To print an object with supports:
 
1.  Open MakerWare. Open the model you

want to print. 
 
2.  Click the Make button or open the File

menu and choose Make It.
 
3.  In the Make dialog, ensure that the

following boxes are checked:

Raft: Select this checkbox to print your 
object on top of a raft. 

Supports: Select this checkbox to print your 
object with supports. [Fig 10.6]
 
4.  Print the object as usual.

SUPPORTS CONTINUED

Fig. 10.6
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In this example, we will print the bird model 
shown earlier.  To do this:
 
1.  Open a browser session and go to 

http://www.thingiverse.com. 

2.  In the Search field in the upper right of the
page, enter “Bird (for putting on things)”.

3.  In the Search Result page, find Bird (for
putting on things). Click on the title link.

4.  In the Thing page for the bird, you will see
a button that says Download This Thing! 
Click this button.

5.  In the Downloads window, click on the
file bird.stl. Thingiverse will download the
file to your local computer.

6.  Start MakerWare. Choose the File menu.
Choose Open. Navigate to the directory 
where you stored the file bird.stl. 

7.  The bird statue should appear in MakerWare.

Fig. 10.7

Fig. 10.8

Fig. 10.9



8. The default size of the bird is very small.
We will resize the object to increase its 
size. [Fig 10.11]

9. Click the Scale button twice. In the
Change Dimensions menu, edit the 
following settings [Fig 10.12]:

Uniform scaling. Ensure that this box  
is checked.

Scale To. Set this field to 200.00% 

10. Click the Make button or choose the File
menu and choose Make It.

11.  In the Make dialog, ensure that the
following boxes are checked [Fig 10.13]:

Raft. Select this checkbox to print your 
object on top of a raft. 

Supports. Select this checkbox to print your 
object with supports. 

12. Print the object as usual.
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Fig. 10.11

Fig. 10.12

Fig. 10.13
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This chapter describes the advanced printing options in the  
MakerWare software.

Advanced 
Printing
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QUALITY [Fig. 11.1]
The settings in the Quality tab affect the 
strength and finish of printed objects.  Each 
Quality option affects particular sections of 
an object and requires some understanding 
of the composition of a 3D printed object.

The MakerBot Replicator 2X begins printing 
your object by putting down several solid 
layers. These initial layers are called the floor 
of the object. If your object has a flat top, 
or a section with a flat top, your MakerBot 
Replicator 2X will print a similar set of solid 
layers there. This top is called a roof. 

The MakerBot Replicator 2X starts each new 
layer of an object by printing some number of 
outlines of that layer. These are called shells. 
If there is more than one shell, the additional 
shells will be nested inside the first one. 

PRINT QUALITY
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ADVANCED OPTIONS
To use the settings under Advanced 
Options, you must select one of 
MakerWare’s base profiles (Low, Standard, 
or High). When you change any of the 
settings in Advanced Options, an asterisk 
will appear next to the profile name 
everywhere it appears in the Make dialog. 
The asterisk indicates that the base profile 
is no longer in its default state. 

NOTE: The settings in Advanced Options never 

edit the base profiles; they only override them. 

MakerWare will save the set of overrides for you, but 

you can always return the profile to its original state 

by clicking the Use Defaults button at the lower left 

of the Advanced Options area. 

These options provide control over specific 
slicing options. To access the advanced 
options, click the Advanced Options button 
at the lower left of the Make dialog. This 
button toggles the visibility of the advanced 
options, which are grouped into three tabs : 
Quality, Temperature and Speed. 

To change a setting in the Advanced 
Options tabs, highlight the current number 
and enter a new one.

Fig. 11. 1



Infill. Everything that is neither shells, nor 
floor, nor roof is filled with an internal lattice 
called infill. [Fig. 11.2] Infill provides your 
object with an internal support structure. 
The number that you enter in this field 
defines the solidity of the printed object’s 
infill. Higher infill percentages will result 
in more threads of infill extrusion that are 
closer together. Lower infill percentages will 
result in fewer threads of infill extrusion that 
are more widely spaced. For a hollow object 
with no internal support structure, enter an 
infill of 0%. For a completely solid object, 
enter 100%. 

For decorative objects, you might want to 
set a low infill percentage--maybe 5 or 10%. 
If you are having trouble with the upper 
surfaces of your object, you might want 
to raise that number. Flat roofs must have 
some structure underneath them so that 
they do not sag. Rounded objects might 
show gaps if there is not enough infill for the 
shells of new layers to adhere to.

More infill will increase the strength and 
weight of your object. It will also increase the 
printing time for the object. For objects with 
a practical purpose, you should use more 
infill. An infill of 40 or 50% usually results in 
a robust object, but if you are able to crush or 
break your object, try raising the amount of 
infill by 10%. 

PRINT QUALITY CONTINUED
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File Name: 20mm calibration box Fig. 11. 2

Design by: Spacexula

Thingiverse: 2064



Shells. Every object you print must have at 
least one shell. You can add as many shells 
as you want and they will print as concentric 
perimeters on each layer. [Fig. 11.3] If the 
layer cannot accommodate the specified 
number of shells, the slicer will just fit in as 
many as possible.

Additional shells, like larger amounts of 
infill, add to an object’s strength, weight, 
and print time. Two or three shells are 
sufficient for most objects. Additional shells 
might help if you see cracks between the 
layers of your object. 

Layer Height. Layer height determines the 
thinness of each printed layer of your object. 
It is often treated as a measure of resolution 
in 3D printing, but it affects resolution only 
on the Z-axis (up and down).

Thinner layers will result in a smoother 
surface, but will also increase print times; 
layers take the same time to print regardless 
of height and thinner layers increase the total 
number of layers to be printed.

The preset layer heights for the MakerBot 
Replicator 2X range from .10 mm to .30 
mm. Layers thicker than .34 mm are difficult 
because the extruded plastic noodle 
emerging from the nozzle is only .4 mm in 
diameter. When the distance between one 
layer and the next approaches the height 
of the noodle, the two layers will not be 
pressed closely together and might not stick 
to each other very well.

Layers thinner than .10 mm are possible, 
but present additional challenges. Smaller 
layers require the plate to be trammed more 
closely to the extruders. Ideally, the distance 
between your extruder nozzles and build 
plate should be one half of your layer height. 

PRINT QUALITY CONTINUED
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File Name: Rock Wall hold 1.0 Fig. 11. 3

Design by: Jeremy007007
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TEMPERATURE [Fig. 11.4]
Temperature settings for the extruders and 
the build plate are grouped together under 
the Temperature tab.
 
Extruders. The extruders will need to be 
heated to approximately 230° C to melt 
and extrude the plastic filament at normal 
operating speeds. Extrusion temperature 
is tied very closely to both extrusion speed 
and the material being extruded. If you are 
experimenting with either of those, you 
might need to experiment with extrusion 
temperature, too.

Speed. Higher extrusion speeds require higher 
temperatures. During printing, plastic filament 
passes into the extruder where it is melted 
before being squeezed out onto the build plate. 
When the plastic melts, heat moves from the 
extruder’s thermal core into the plastic, heating 
the plastic and cooling the extruder. The heater 
sends heat to the extruder to maintain the 
temperature required to melt the plastic, but 
when the plastic moves faster, it pulls heat out 
of the extruder faster, too. 

If you are experimenting with extrusion 
speeds faster than the standard 80 mm/s 
you might have to raise your extruder 
temperature, too. And if you are printing 
slower than the standard 80 mm/s, 
you might want to lower the extruder 
temperature below the standard 230° C.

Material . Different kinds of plastic have 
different melting points. ABS needs more 
heat to melt than PLA, for example, and PVA 
needs less. At higher speeds the temperature 
required to keep the extruder hot can even 
this out, which is why 230° C is a good 
extrusion temperature for both ABS and PLA. 

TEMPERATURE
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TEMPERATURE CONTINUED

If you are experimenting with different materials 
or extrusion rates, you need to consider the 
properties of the material you are using. 
Additives in plastic, including coloring agents, 
can also affect a particular filament’s properties, 
so if you are having trouble with a new roll of 
filament, temperature might be the culprit.

Build Plate. A heated build plate helps 
printed plastic objects to stick to the 
printing surface without warping. If prints 
are not adhering to your build plate, and you 
have tried cleaning and releveling, try raising 
the plate temperature a few degrees.

ABS adheres best at temperatures between 
100° and 115° C. If you adjust the plate 
temperature to 115° C and continue to have 
adhesion problems, the problem probably 
lies elsewhere. 

PLA is much less likely to warp, and tends 
to work well on an unheated build plate, 
but having a heated plate can improve 
large PLA prints by relaxing the bottom 
layers. Temperatures in the 40° to 60° C 
range work well with PLA. The material of 
the printing surface is also a factor here. 
PLA sticks well to blue tape at much lower 
temperatures, but will not stick well to 
Kapton tape even at high temperatures.

SPEED [Fig. 11.5]
Everyone wants their MakerBot to move 
faster so they can print things more quickly. 
Our default print speed is 80 mm/s, and 
if you want to print faster, you might have 
to adjust more settings than the extrusion 
speed. Print speeds are closely tied to 
temperature settings and to the mechanical 
capabilities of your MakerBot.

Speed while Extruding. Speed while 
Extruding controls two things: the speed at 
which the extruder is moving while printing and 
the speed at which plastic is coming out of the 
nozzle. These speeds are the same because 
that makes for the most even extrusion. 

SPEED

Fig. 11.5
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SPEED CONTINUED

Because moving filament through the 
extruder at higher speeds pulls heat out 
of the extruder more quickly, substantial 
increases in speed require increases in 
extrusion temperatures. MakerBot does not 
recommend extruder speeds higher than 
120 mm/s.

Speed while Traveling. Traveling is when 
the extruder moves without extruding 
filament. Because travel moves are not 
limited by the temperature at which the 
plastic can be extruded, they can be faster 
than moves that do include extrusion.

CUSTOM PROFILES
Additional advanced options are available 
through Custom Profiles. Custom profiles 
allow you to edit the slicing engine’s profile 
settings directly instead of overriding them 
by using the Advanced Options settings.  
For more information on using custom 
profiles, see http://www.makerbot.com/
support/makerware/.
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Thingiverse is a website created by MakerBot. You can access the website 
at http://www.thingiverse.com. Thingiverse allows MakerBot users and 
others to share design files for 3D objects. You can download files from 
Thingiverse and print them on your MakerBot Replicator 2X. You can 
also upload your own original designs to Thingiverse for others to print. 
Thingiverse is always changing, so visit thingiverse.com regularly to check 
out new features.

This chapter explains how to navigate Thingiverse, find objects to 
download and interact with other users.

Introduction to 
Thingiverse

12



CREATING AN ACCOUNT [Fig. 12.1]
To create a Thingiverse account, click the 
Join Thingiverse button at the top right of 
any Thingiverse page. With a Thingiverse 
account you can:

•   Access the Dashboard
•   Publish Things
•   Customize Things
•   Like and Collect Things
•   Follow other Users 
•   Launch Apps

NAVIGATING THINGIVERSE
To view the Thingiverse website, go to 
http://www.thingiverse.com

The links in the top navigation bar will allow 
you to reach different areas of Thingiverse: 
 
Dashboard. [Fig. 12.2] After you create an 
account on Thingiverse, the Dashboard 
allows you to view a one-page overview of 
your uploads on Thingiverse (for example, the 
number of other users who downloaded your 
designs) for the last 30 days and the activity 
associated with any Thingiverse users you 
have chosen to follow. [Fig. 12.3] If you are not 
logged into Thingiverse, clicking the Dashboard 
link will take you to a Sign In screen. 
 
Explore. Allows you to find Things in a 
number of different ways. You can:

•   Sort by New and Noteworthy, Featured, 
Popular and Recently Made, see only 
Remixed or Customizable objects, view 
a random selection of objects, or go to 
The Firehose for an unfiltered view of 
all new objects.

•   View Collections of Things curated by 
other users.

THINGIVERSE

85INTRODUCTION TO THINGIVERSE

Fig. 12. 1

Fig. 12. 2

Fig. 12. 3



•   Browse all Things by Categories like Tools, 
Household, and Art.

•   View Apps created using the Thingiverse  API.
 
Create. Allows you to publish your 
own Things, create objects using the 
Customizer, start a Collection of other 
users’ Things, or publish an App using the 
Thingiverse API.

Search. Allows you to search Thingiverse 
using simple text matching. 

THE THING PAGE
When you find a Thing to make, click on the 
image or name of the Thing to go to the Thing 
page. [Fig. 12.4] On the Thing page you can get 
more information about the Thing, download 
files to make the Thing, and give feedback to 
the user who uploaded the Thing. 

To download a Thing:
Click on the Download This Thing! button at 
the right of the page to open the Downloads 
window. The Downloads window includes 
a Download All Files button, which will 
download any files associated with 
the Thing as a ZIP file. [Fig. 12.5] It also 
includes a list of all the files associated 
with the Thing, which can be downloaded 
individually. 

To show that you Like a Thing: 
If you like something that someone has 
uploaded to Thingiverse, let them know!  
The Like button is a heart icon at the 
upper right, above icons that allow you 
to add a Thing to a Collection, or make a 
comment. [Fig. 12.6]

THINGIVERSE CONTINUED
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To show that you Made a Thing:
When you print something downloaded 
from Thingiverse, it’s good manners to show 
your work. 

•   Click the “I made one!” button in the 
right sidebar. [Fig. 12.7]

•   This will take you to a new page where 
you can upload an image and add a 
description of the Thing you made. 

•   Click Create at the lower right corner 
of the page to save the record of your 
Made thing. 

To Follow a user:
If you admire another Thingiverse user 
and want to know when they publish new 
designs, add Things to a Collection, or have 
a Thing featured on the front page, Follow 
them. You can find the Follow button on any 
Thing page, to the right of the Thing image 
and directly underneath the name of the 
user who published the Thing. [Fig. 12.8]

THINGIVERSE CONTINUED
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Customizer is an application available on thingiverse.com. Customizer 
allows users to change the parameters of an object before downloading 
the STL file and printing it.

Customizer allows users to make changes to an object directly from 
Thingiverse, using an intuitive user interface. When a user clicks the Create 
Thing button,  Customizer saves the user’s changes and creates an STL file 
that the user can download and print. 

This chapter will explain how to customize and download  
an object using Customizer.

Using the 
Customizer in 
Thingiverse

13



VIEWING CUSTOMIZABLE THINGS
To view a list of Things that you can 
customize with the Customizer application:

1. Go to http://www.thingiverse.com. 

2. On the home page, click the Explore 
link at the top of the page and then click 
Customizable Things.

3. Thingiverse will display the Customizable 
page, with a list of Things that you can 
customize with the Customizer application.

Each customizable Thing has a set of 
parameters you can edit in Thingiverse. 
These parameters are created by the user 
who uploaded the Thing. To view and 
manipulate a customizable Thing:

1. Find the thing, either through the Search 
tool or by viewing the list of Customizable 
Things. Go to its Thing page.

2. In the Thing page, select the button 
Open in Customizer. [Fig. 13.1]

3. You can now view the list of 
customizable parameters for the thing.

CUSTOMIZING A THING
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SAVING AND DOWNLOADING  
YOUR CUSTOMIZATIONS
After you change one or more parameters 
for a customizable thing, you can save your 
customizations and download the file for 
printing. To do this:

1. In the Customizer page, click the Create 
Thing button.

2. The Creating Your Customized STL 
dialog box appears. You can enter values 
in the following fields:

Name: Name of the file for the customized thing.

Publish New Thing: Select this checkbox to 
publish the STL file to Thingiverse.

Email me when it’s done:  If you select this 
checkbox, Thingiverse will send you an email 
when your STL file has been created.

Create Thing: Click this button to generate  
the STL file. 

3. The Creating your Customized STL dialog 
box will display a message telling you that it 
is generating your file. Click the link Go to my 
Queue to see the status of the file. [Fig. 13.2]

4. When your file appears in the queue 
with the status Done!, click the View Thing 
button. Unless you had Publish New Thing 
checked, the Thing page will be private.

5. In the Thing page for your new file, click 
the Download This Thing button. 

6. In the Downloads dialog box, select the 
appropriate file to download

7.  You can save the file to your local computer 
or open the file with MakerWare and print it.

Fig. 13. 2



CUSTOMIZING A THING CONTINUED

91USING THE CUSTOMIZER

EXAMPLE OF CUSTOMIZING A THING
This section will walk you through the steps 
to customize a thing with the Customizer 
application, create the STL file, and 
download the STL file. We will customize 
the thing called Customizable Round Trays. 
To customize this thing:

1. Go to go to http://www.thingiverse.com. 

2. On the home page, use the Search field 
in the upper right. Search for “Round Trays”.

3. In the Search Results page, find 
“Customizable Round Trays by walter”. 
Click on the name of the thing. 

4. In the Thing page for the thing, click the 
button Open in Customizer.

5. The Customizer page appears and 
displays the thing “Customizable  
Round Trays”. 

6. In the Parameters tab, we can edit the 
following parameters [Fig. 13.3]:

Tray Diameter: You can specify the  
diameter of the tray. In our example, set the 
tray diameter to 75.

Tray Height: You can specify the height of 
the sides of the tray. In our example, set the 
tray height to 50.

Tray Rounding:  Specifies the curvature of 
the bottom of the tray. In our example, set 
the curvature to 3. 

Tray Sidewall: Specifies the thickness of 
the vertical walls, in mm. In our example, set 
the thickness to 1.2. 

Fig. 13. 3



Tray Bottom: Specifies the thickness of the 
bottom of the tray, in mm.

In our example, set to 2.0.

Resolution: Specifies STL resolution. In 
our example, select Medium. [Fig. 13.3]

7. To save your changes and create an STL 
file you can download, click the Create 
Thing button.

8. In the Creating Your Customized STL 
dialog, enter the following: 

Name: Name of the new STL file. In our 
example, enter “Customized Round Tray”.

Publish New Thing: Select this checkbox 
to publish the STL file to Thingiverse. In our 
example, leave this unchecked. 

Email me when it’s done: Thingiverse  
will send you an email when your STL  
file has been created. In our example,  
leave this unchecked.

CUSTOMIZING A THING CONTINUED
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Create Thing: Click this button to begin 
generating the STL file. [Fig. 13.4]

9. The Creating your Customized STL dialog 
box will display a message telling you that 
it is generating your file. Click the link Go to 
my Queue to see the status of the new file. 

10. When your file appears in the queue 
with the status Done!, click the View 
Thing button.

Unless you had Publish New Thing 
checked, the Thing page will be private.

11. In the Thing page for your new file, click 
the Download This Thing button.

12. In the Downloads dialog box, select the 
appropriate file to download.

13. You can save the file to your local 
computer or open the file with 
MakerWare and print it.
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Your MakerBot Replicator 2X Experimental 
3D Printer uses ABS plastic filament, 1.75 
mm in diameter, to print objects. [Fig 14.1] 
The Replicator 2X can also use 1.75 mm 
filament made from other plastics with 
similar properties. The filament used in 3D 
printing is also known as plastic welding 
rod and is used in other applications, but 
filament made for 3D printing needs to be 
more consistent in diameter. 

Sometimes 1.75 mm plastic filament can 
vary in size between 1.65 mm and 1.85 mm. 
[Fig 14.2] The extruders in the MakerBot 
Replicator 2X can accommodate this 
range of sizes. The consistency of filament 
diameter is more important than the size 
of the diameter. Filament that is thicker in 
some places than in others is difficult for the 
extruder to grip. It can also result in poor print 
quality: a section of plastic that is too thin 
will result in a section of your print that does 
not contain enough plastic and a section 
of filament that is too thick will result in a 
section of your print that contains too much.

If you load a new roll of filament that is 
slightly more thick or thin than your previous 
roll, the extruders might feed too much or too 
little plastic for your print. To fix this problem, 
adjust the feedstock diameter in the 
MakerBot Slicer through the custom profiles 
feature in MakerWare. For more on custom 
profiles and the feedstock diameter setting, 
see the Advanced MakerWare settings page 
at www.makerbot.com/support/makerware/
documentation/advanced.

Be careful with your filament. Keep it dry; 
humidity might cause it to expand. Avoid 
letting the filament loosen on the roll; this 
can result in tangles which could cause your 
filament to break or get stuck during a print 
and the print to fail.

FILAMENT BASICS
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1.85

Fig. 14.1

1 milimeter = 1 inch  Fig. 14.2



ABS is short for Acrylonitrile Butadiene Styrene. It is made of a combination of those three 
plastics. The three plastics can be mixed in different proportions to formulate ABS intended 
for different uses. 

ABS is tough and somewhat flexible. ABS becomes softer with increased temperatures,  
but at the extrusion temperatures used in a MakerBot it remains fairly viscous. That means 
that ABS melts quickly inside the extruder but doesn’t drip during travel moves. ABS can  
also withstand heat well enough that we use it to make the plastic components of the 
Replicator 2X’s extruders.

ABS FILAMENT
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TROUBLESHOOTING

ABS has a high rate of thermal expansion, 
which means it expands as it is heated and 
shrinks as it cools. This can cause certain 
problems when printing.

Warping: Thermal expansion means that 
layers closer to the extruder are cooling and 
shrinking, causing strain on the layers below. 
The shrinking layers pull at the stable layers, 
warping the object. 

Cracking: Cracking is a different 
manifestation of the same problem. When 
the bond between two layers is not strong, 
sometimes the shrinking of a section of 

newer layers will cause it to separate from 
the previous layers. This results in horizontal 
cracks in the side of the object.

Increasing the extrusion temperature 
creates a stronger bond between each
pair of layers, but will also increase the 
temperature differential between new 
layers and older layers. The best way to 
combat both warping and cracking is to 
keep the whole object warm. This is why 
the MakerBot Replicator 2X is fully enclosed 
-- the heat of the extruder, instead of 
dissipating, stays in the build area and keeps 
the object at a more steady temperature.
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TROUBLESHOOTING

PLA FILAMENT

Extruder clogs: PLA is hard, dense, and has 
a low coefficient of friction, which means 
that it’s slippery and it can be difficult for 
the drive gear inside your extruders to grip. If 
there is not enough tension on the bearing 
holding the filament against the drive gear, 
the teeth of the gear will not bite into the 
filament, but will scrape against it, stripping 
the filament. If you think you need to increase 
the tension on the bearing, contact MakerBot 
Support for advice.

PLA is also sensitive to heat. At temperatures 
above 55° C, objects made from PLA will 
start to get soft enough that they might 
deform if force is applied to them. At 
temperatures of above 150° C, objects 
made from PLA might start to lose their 
shape. PLA filament should not be heated 
to temperatures above 250° C because the 
plastic will start to break down.

If plastic stops extruding partway through your 
PLA prints, it is probably because the plastic is 
overheating. Try lowering extrusion temperature, 
removing the enclosure lid, and opening the 
door of the MakerBot Replicator 2X.

PLA, or Polylactic Acid, is a biodegradable plastic with features that make it great for 3D 
printing -- it doesn’t give off bad-smelling fumes and it has a low rate of thermal expansion, 
so it doesn’t warp very much.

PLA is harder and slightly brittle. It is more likely to snap than bend, but that does not mean 
that PLA is easily breakable. PLA also stays flexible for a short while as it cools.
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Updating 
Firmware
To ensure that your MakerBot Replicator 2X provides optimum 
performance, you must keep the firmware up to date. 

15



Keeping your firmware up to date will ensure 
that your MakerBot Replicator 2X always 
operates at its best. When a new version of 
your bot’s firmware is available, MakerWare 
will display a message letting you know that 
it’s time to update. [Fig 15.1]

To update your firmware, follow these steps

1.  Locate the USB-A to USB-B cable that
came with your MakerBot Replicator 2X 
and use it to connect your Replicator 2X 
to your computer.

2. Choose “Upload Firmware” from the
MakerBots menu. MakerWare will 
walk you through the rest of the steps 
necessary to upload new firmware. 
[Fig 15.2] 

When your MakerBot Replicator 2X 
restarts it will display the number of the 
new firmware version. [Fig 15.3]

FIRMWARE
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After you print an object, you can smooth it, retouch it, and paint it. This 
chapter will describe one method of finishing a printed object and then 
give a broad overview of other methods.

Finishing Things
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FINISHING AN OBJECT WITH PRIMER  
AND SANDPAPER
This method of finishing requires a matte 
gray spray primer, lightweight painters’ 
spackle, and fine grit sandpaper.

1.  Prime the object.
For a smooth, even coat of primer, keep 
your hand moving as you spray the object 
and spray only in short bursts.

2.  Sand the object.
Use a fine grit sandpaper on the entire 
surface of the print. The primer will come 
off in places, revealing the layer lines. You 
can also use a variable speed rotary tool 
instead of sandpaper, but be careful to use 
it only at low speeds: using a rotary tool 
at  high speeds will generate heat, which 
could melt the surface of your object.

3.  Apply spackle.
Use your finger or a paintbrush to apply 
spackle perpendicular to the layer lines. 
You can help the spackle to dry more 
quickly by setting it in the sun or applying 
hot air using a hair dryer.

4. Repeat steps 1 – 3. 
Continue priming, sanding, and 
spackling until you are satisfied with the 
appearance of the object. Apply only light 
layers of primer to avoid buildup. Apply 
paint to the final layer of primer.

OTHER METHODS
Retouching.
You can fix minor imperfections in an object by:

• Spraying with automotive spray filler
• Manually applying wood putty
• Manually applying modeling epoxy
• Making slurry from acetone and ABS

of the same color you want to retouch.  
You can then paint the slurry on to  
the imperfection.

Smoothing.
To smooth an object, you can:

• For prints made out of ABS, rub the 
surface with a small amount of acetone 
on a cloth.

• Rub the surface with fine-grit 
sandpaper (dry or wet) and then wash 
with detergent and water.

Painting.
• You can paint objects made with ABS

with acrylic paints and spray paints. 
• You can prep for painting with a

urethane-based primer.

FINISHING THINGS
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3D printers can make objects that more traditional manufacturing 
processes, like milling and injection molding, cannot, but it also comes 
with its own set of strengths and weaknesses. Keep these guidelines 
in mind when designing models intended for 3D printing to produce 
successful printed objects.

Designing for 3D 
Printing

17



OVERHANGS [Fig. 17.1]
As your MakerBot prints your object, each 
layer of plastic rests on the one below. When 
an object has straight sides, a new layer 
will be fully supported by the previous layer. 
But when an object has parts that angle 
outwards (overhangs) some part of the new 
layer is unsupported. If it’s just a thin sliver of 
the perimeter, the layer will still have enough 
support, but if more than half of that outer 
perimeter has nothing to rest on, you might 
see drooping or dropped threads of plastic. 
To make sure at least half of each layer’s 
outer perimeter is supported, avoid creating 
overhangs that form an angle greater than 
45° from the vertical.

BRIDGING [Fig. 17.2]
A thread of extruded plastic that crosses from 
one supported area to another supported area 
over an unsupported area is called a bridge. 
Because the thread is supported at both 
ends, the unsupported middle does not cause 
problems. But if the unsupported section is too 
long, you might see sagging in the middle. Your 
MakerBot Replicator 2X should handle bridges 
of 10 mm well, but you will probably see some 
sagging on bridges of 20 mm.

DETAIL SIZE
There is no equivalent to pixel size on a 
MakerBot. Layer height is used as a measure 
of resolution, but it only measures resolution 
in the Z-axis. Your MakerBot can produce its 
finest detail on the Z-axis. The high quality 
setting uses .1 mm layers, and it is possible to 
produce layers that are even thinner. Design 
with layer height in mind for even more 
precision: a feature .2 mm tall will be two 
layers tall when printed with .1 mm layers and 
one layer tall when printed with .2 mm layers, 
but will not be the correct height if printed 
with .15 mm or .25 mm layer heights.

DESIGN GUIDELINES
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File Name: Massive Overhang Test  Fig. 17. 1

Design by: thingster

Thingiverse: 40382

File Name: Three 1:24 Windsor Chairs  Fig. 17. 2

Design by: PrettySmallThings

Thingiverse: 21999



There are two components to figuring out 
what detail size you can achieve on the 
X- and Y axes. First is positioning accuracy. 
Positioning accuracy tells us how precisely 
the extruder can find the spot it is looking for 
on a plane. X and Y positioning accuracy on 
your Replicator 2X is about .01 mm.
 
That’s a number you should consider when 
modeling shallow surface detail, but for small 
stand-alone or protruding features, you will 
have to go larger than that. The limiting factor 
here is the layer width. The layer width is the 
same as the diameter of the extruder nozzle: 
.4 mm. Because a single line of extrusion is 
never narrower than .4 mm, no printed feature 
can be narrower than .4 mm. 

However, most slicing engines still can’t handle 
features that small because they can’t print 
a line alone: each layer perimeter must be a 
closed loop. That means that the smallest 
feature you can actually print is .8 mm -- the 
width of two extruded lines side by side. The 
MakerBot Slicer’s spur settings work to correct 
this by allowing shapes that are not closed 
loops, but these features are experimental.

ORIENTATION
Many of the problems you might run into 
while trying to print difficult models can be 
prevented by changing the orientation of 
the model on the build plate.

MINIMIZE SUPPORT MATERIAL
You can build an object of any shape using 
tearaway support structures, but supports 
can be difficult to remove and use up 
plastic. Make sure your object has a flat side 
to rest on. Orient your object to minimize 
overhangs and bridges. For example, 
printed right-side-up, these tables would 
have unprintable bridges and unprintable 
overhangs, but upside-down they print 
easily. [http://www.thingiverse.com/
thing:18982] 

MAXIMIZE OBJECT STRENGTH
Another thing to consider is the “grain” of the 
printed object. A thin cylinder printed upright 
will be composed of a series of circles placed 
on top of one another. If you try to break it 
in half, it will have as many natural breaking 
points as it has layers, and will snap easily. If, 
on the other hand, it is printed on its side, the 
layers will run up along the cylinder, and every 
layer will have to bend in order for the cylinder 
to break. Keep this in mind when designing 
objects, especially functional ones. A spool 
holder is a good example of an object that 
should be printed on its side for strength.

DESIGN GUIDELINES CONTINUED
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ABS: Acrylonitrile butadiene styrene, a 
widely used thermoplastic, and the primary 
material used for making things on the 
MakerBot Replicator 2X.

BUILD PLATFORM: The support for the 
heated build plate. The build platform 
includes knobs for manual leveling.

DRIVE GEAR: The gear that pushes the 
MakerBot Filament into the heated part of 
the extruder.

DUAL EXTRUSION: A process in which two 
extruders loaded with two different colors 
or kinds of plastic work together to 3D print 
an object.

ENCLOSURE LID: The clear acrylic hood 
that helps keep warm air inside the 
MakerBot Replicator 2X. The enclosure lid is 
shipped separately.

EXTRUDER: The assembly that draws  
the filament from the spool, melts it and 
pushes it through a nozzle onto the heated 
build plate. Your MakerBot Replicator 2X 
has two extruders.

EXTRUDER FANS: The fans that keep the 
MakerBot Replicator 2X extruder motors 
cool and disperse heat from the heat sinks.

EXTRUDER LEVER ARMS: The levers 
on the MakerBot Replicator 2X extruders. 
These move the bearing inside the extruder 
away from the drive gear, allowing for easier 
loading and unloading of filament.

FAN GUARDS: The grills that protect  
the extruder fans and protect the user  
from the fans.

FILAMENT GUIDE TUBES: The plastic 
tubes that guide the MakerBot Filament 
from the filament spools to the extruders.

GANTRY: The metal rods that allow the 
MakerBot Replicator 2X extruders to move 
on the X and Y axes.

GCODE: The computer language used 
to describe the toolpath your MakerBot 
Replicator 2X will use to 3D print an object. 
GCode is converted to X3G before being 
saved to your SD card.

HEAT SINKS: The components that 
dissipate heat from the cartridge heaters. 
They look like aluminum plates with fins.

HEATED BUILD PLATE: The heated surface 
on which the MakerBot Replicator 2X builds 
an object.

INFILL: The printed internal lattice that 
provides structural support for your object.

KAPTON TAPE: A heat-resistant film 
that adheres well to ABS plastic at high 
temperatures. Use it to cover the heated 
build plate so that objects will stick to the 
plate during the build.

LCD CONTROL PANEL: The liquid-crystal 
display at the front lower right corner of 
the MakerBot Replicator 2X. This control 
panel provides status information about 
the MakerBot Replicator 2X and includes 
control menus and diagnostics.

GLOSSARY OF TERMS
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MAKERBOT FILAMENT: 1.75mm diameter 
plastic welding rod. This is the feedstock 
for your MakerBot Replicator 2X. MakerBot 
Filament comes in ABS, PLA, and PVA 
plastics. The MakerBot Replicator 2X is 
optimized for ABS.

MAKERWARE: Free software created by 
MakerBot that allows you to load, rotate, 
scale, and move 3D models and create the 
toolpaths the MakerBot Replicator 2X uses 
to build objects.

MANIFOLD: A term used to describe 3D 
models that consist of one completely 
enclosed three-dimensional shape with no 
holes, reversed faces, or extra geometry. 
Non-manifold models will cause problems 
for 3D printing and other applications.

MOTOR ASSEMBLY: The stepper motor 
and the drive block that push filament  
into the extruder. Each extruder contains  
a motor assembly.

MOTOR WIRES: The bundle of electrical 
wires that provides power to the motors.

NOZZLES: The openings at the end of the 
extruders from which melted MakerBot 
Filament emerges to be spread onto the 
build plate.

PLA: Polylactic acid is a renewable 
bioplastic, and one of the materials from 
which MakerBot Filament is made.

PVA: Polyvinyl alcohol is a water-soluble 
plastic that is sometimes used for 
dissolvable support structures.

POWER SUPPLY: The A/C power supply 
for the MakerBot Replicator 2X. It includes a 
block and two plugs.

REPLICATORG: Free, open source software 
that allows you to manipulate and edit STL 
files and GCode files and save them to be 
printed on the MakerBot Replicator 2X. 

SD CARD: Secure Digital memory card that 
can store digital data and be read by the 
MakerBot Replicator 2X. The SD card used 
with your Replicator 2X must be formatted 
FAT 16 with a maximum capacity of 2 GB.

SHELLS: Printed outlines defining the shape of 
each layer of an object.

SPACERS: The plastic pieces that keep the 
extruder fans and heat sinks secure and in place.

SPOOL HOLDERS: The plastic pieces 
that attach to the back of the MakerBot 
Replicator 2X and hold the spools of 
MakerBot Filament. The spool holder 
ensures that the MakerBot filament is fed 
evenly to the extruders.

STL: A widely used file format for 3D 
models.

.THING: A file format used by MakerWare 
that allows you to print multiple 3D models 
on the same build plate.

THINGIVERSE: A website for uploading and 
downloading 3D model files for use with the 
MakerBot Replicator 2X.

GLOSSARY OF TERMS CONTINUED
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GLOSSARY OF TERMS CONTINUED

THREADED ROD: The long metal rod behind 
the build platform that is threaded along its 
entire length. This rod allows the build platform 
to move up and down along the Z-axis.

TOOLPATH: The set of instructions your 
MakerBot will use to build an object. 
Toolpaths for the MakerBot Replicator 2X 
must be saved as an X3G file.
USB CABLE: A cable that allows your 
computer to communicate with the MakerBot 
Replicator 2X in order to update firmware.

.X3G: A compact format for describing the 
toolpath your MakerBot Replicator 2X will 
use to 3D print an object.
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CONTACT US

SUPPORT

SALES

FEEDBACK

makerbot.com/support

Our website has extensive documentation and troubleshooting 

information about your MakerBot Replicator 2X Experimental 3D 

Printer. It’s a great resource when you want to try to solve issues 

quickly on your own. 

support@makerbot.com

If you ever need help resolving an issue with your MakerBot 

Replicator 2X, send an email to the address above to open a ticket 

with the MakerBot Support Team. To help us understand your 

problem from the start, it is very helpful to include pictures or a 

video as attachments on your email.

sales@makerbot.com

To learn about other MakerBot products, including MakerBot 

Filament, please email the address above, or call our Sales Team at 

1-347-334-6800.

thoughts@makerbot.com

For general questions, or to tell us what’s on your mind, send an 

email to the address above. We love to hear from you, and using 

this email address helps keep our Sales and Support lines free for 

customers in need.
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WARRANTY, RETURNS, AND REPLACEMENT POLICY

MakerBot products do not carry a long-term warranty. Returns are possible only on unaffected 

items, within 14 days of receipt. After such time, all sales are considered final. “Unaffected” 

means a device has never been assembled, powered up, programmed, or otherwise changed. 

MakerBot cannot accept returns on purchased items that have had electrical power applied to 

them, or been otherwise programmed, changed, or affected.  However, we will provide parts or 

service on items that prove to be defective from the time of manufacture, and we’ll always work 

with you to get your bot running again.

TERMS OF SERVICE

Please be advised of the following terms (the “Terms”) regarding this User Manual (the “Manual”):

All information in this Manual is subject to change at any time without notice and is provided 
for convenience purposes only. MakerBot reserves the right to modify or revise the Manual 
in its sole discretion and at any time. You agree to be bound by any modifications and/or 
revisions. Contact the MakerBot Support Team for up-to-date information.

The design of this Manual and all text, graphics, information, content, and other material are 
protected by copyright and other laws.  The contents are Copyright (c) 2009, 2010, 2011, 2012, 
2013 MakerBot Industries LLC, or our respective affiliates and suppliers.  All rights reserved.  
Certain trademarks, trade names, service marks and logos (the “Marks”) used are registered 
and unregistered trademarks, trade names and service marks of MakerBot and its affiliates.  
Nothing contained in this Manual grants or should be construed as granting, by implication, 
estoppel, or otherwise, any license or right to use any Marks without the written permission of 
MakerBot. Any unauthorized use of any information, materials, or Marks may violate copyright 
laws, trademark laws, laws of privacy and publicity, and/or other laws and regulations.



A
ABS  95–96 See also loading filament

diagram  14
troubleshooting  96

accessory box  14–15
adding an object in MakerWare  51
advanced printing options  77–80

B
bar mount location  13
bridging  103
build plate

leveling  22
location  12
temperature  81–82

build platform location  12
build volume  8

C
cartridge heaters location  13
clogging  97
copying objects See duplicating objects 

in MakerWare
cracking  96
creating an account in Thingiverse  85
custom profiles  82
Customizer  89–92

D
designing for 3D prints  103–104

object strength  104
orientation  104
support material  104

downloading
a customization  90
MakerWare  47

drive blocks location  13
dual extrusion  64–65
duplicating objects in MakerWare  59

E
enclosure door handle

diagram  14
installation  16
location  12

enclosure lid installation  18
extruder cable mount location  13
extruder carriage location  13
extruder fans location  13
extruder lever arms location  13
extruder motors location  13
extruder nozzles location  13
extruders

diagram  13
disassembly  29
location  12
unpacking  15

extrusion speed  80

INDEX



F
fan bolts location  13
fan guards location  13
filament  95–97 See also ABS; See also PLA

diameter  8
loading  24–31
troubleshooting  28
unloading  27

filament guide tubes
diagram  14
installation  17
location  12

filament spool
location  12
mounting  18

file formats
MakerWare  57

file types  8, 43
OBJ  43
STL  43
Thing  43
X3G  44

finishing prints  101
firmware  99
Fused Filament Fabrication (FFF)  9

G
gantry system, location  12
GCode  43
General Settings  34
guide tubes See filament guide tubes

H
heated build plate See build plate
heat sinks location  13
hex wrenches, diagram  14

I
importing files in MakerWare  58
infill  78–79
Info and Settings Menu  34–35
installing MakerWare  47

K
Kapton tape diagram  14

L
layer height  79–80
layer height settings  8
LCD menus  31–35
LCD panel
location  12
leveling the build plate  22–24
loading filament  24–31

M
MakerWare

adding objects  59
advanced options  77
copying objects  59
download and installation  47
file formats  57
importing files  58
keyboard shortcuts  54–55, 55–56
moving objects  58
navigation  48
printing files  61
quality tab  77
saving files  61
scaling objects  60
speed tab  81
temperature tab  80
troubleshooting  55

motor cable connectors location  13
moving an object in MakerWare  49

INDEX CONTINUED



N
nozzle diameter  8

O
OBJ files  43
overhangs  103

P
physical dimensions  8
PLA  97

troubleshooting  97
positioning precision  8
powering on  19

power supply
attaching  19
diagram   14

printing
advanced options  77–80
cancel  36
change filament 36
examples from Thingiverse 63–65
from the included SD card 39, 40
pause  36
with both extruders  64

print quality  69, 77–80
PTFE-based grease diagram  14

Q
quality 77

infill 78
layer height 79
shells 79

R
rafts

example 73
troubleshooting 71

resolution See print quality
rotating an object in MakerWare 50

S
saving a file in MakerWare  61
scaling an object in MakerWare  50
SD card

diagram  14
example prints  40
exporting to  61
models  40
printing from  39, 40

software bundle  8
spacers location  13
specifications  8
speed  81

while extruding  81
while traveling  82

spool See filament spool
spool holders

diagram  14
installation  17
location  14

STL files  43
importing from modeling application  58
saving  61

support
example  73

support card
and leveling  22–23
diagram  14

supports  71, 104
troubleshooting  72

INDEX CONTINUED



T
tape applicator diagram  14
temperature  80

of build plate  81
of extruders  80

thermal cores location  13
Thing files  43

saving  61
Thingiverse

creating an account  85
customization  89–93
dashboard  85
downloading files from  57, 86
example prints  63
exploring  85
liking a thing  86
navigation  85

threaded Z-axis rod location  12
troubleshooting

MakerWare installation  47
printing  96
rafts  71
unloading filament  29–30

U
unclogging  97
unloading filament  27
unpacking  15
USB cable diagram  14

V
viewing an object in MakerWare  49

W
warping  96

X
X3G  44

Z
Z Pause Height  37

INDEX CONTINUED



MakerBot             One MetroTech Center, 21st Floor, Brooklyn, NY            support@makerbot.com            makerbot.com


